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Pendamping Berselancar Salam!Salam!

eoTek Go Underground ? Itu mungkin yang menja-
di pertanyaan anda begitu melihat fokus NeoTek
bulan ini. Memang sebelum akhirnya software

cracking dipilih untuk mengisi majalah kesayangan anda,
telah terjadi perdebatan di kalangan redaksi maupun di milis
sejauh mana NeoTek dan milisnya boleh  masuk ke wilayah
abu-abu  ini.

Sejauh untuk memberi wawasan dan mendorong minat
belajar, sah-sah saja NeoTek membahas hal ini. Seperti
halnya hacking, seni software cracking merupakan pisau
bermata dua dan kami yakin anda akan memanfaatkannya
untuk hal-hal yang positif.

Redaksi
rredaksi@neotek.co.id

Hormati hak cipta orang lain,Hormati hak cipta orang lain,
walaupun  anda twalaupun  anda telah menguasaielah menguasai

ilmu  ilmu  software crackingsoftware cracking

NN

• Mempelajari seni software cracking memberi dorongan untuk belajar komputer
leboh lanjut, khususnya assembly dan machine language.

Bagaimana menghubungi NNEEOOTEK?TEK?
KONTRIBUSI ARTIKEL
redaksi@neotek.co.id

SURAT PEMBACA
support@neotek.co.id

WEBMASTER
webmaster@neotek.co.id

PEMASARAN
pemasaran@neotek.co.id

ADMINISTRASI IKLAN
Tel. 021-5481457 Fax. 021-5329041
Kontak langsung iklan: 0816-971642

SIRKULASI NEOTEK
Tel. 021-3854764

ALAMAT REDAKSI
Gedung Cahaya Palmerah Suite 503
Jl. Palmerah Utara III No. 9
Jakarta 11480

NeoTek menyediakan CD
yang berisi program-
program yang dibahas
pada NeoTek nomor ini:

• Armed Linux
• Cygwin
• GNUChess source code
• Winboard 4.2.3
• GIMP for Windows
• Flash 5.0
• SWiSH 2.0
• Win32 Disassembler
• ASPEdit
• Personal Web Server
• ChemSketch 3.0
• Conversion Artist

+ utilitas khusus ilmu kimia
seperti ChemBasic, ACD/I-
Lab Add-on, dan Spectral
Viewer.

Dapatkan CD-ROM-nya
dalam satu paket dengan
majalah NeoTek:

Majalah + CD Rp19.500
CD saja Rp15.000

Hubungi
Bagian Sirkulasi
Majalah NeoTek
Tel.   (021) 548 1457
Faks. (021) 532 9041

email:
pemasaran@neotek.co.id
Kontak: Elvi R. Nainggolan

MILIS PARA NEOTEKER
http://groups.yahoo.com/group/majalahneotek

www.neotek.co.id

Dapatkan juga bundel Neotek

Bundel I: NeoTek Vol. I, No. 1-6

Bundel II: NeoTek Vol. I, No. 7-12

Rp59.000
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Daftar Isi

Daftar IsiDaftar Isi
NeoStartNeoStart

NeoTNeoTek Vek Vol. Iol. I I No. 4I No. 4
NeoStyleNeoStyle NeoTNeoTutorutor

Milis NeoTek
Cara mudah menjadi NeoTeker
dengan mendaftar menjadi

anggota milis Majalah NeoTek.

7 SWiSH 2.0
SWiSH adalah program
animasi untuk halaman Web

yang makin banyak penggunanya.
SWiSH versi 2.0 memberikan banyak
fitur baru yang tidak dijumpai pada
versi 1.5.

12

Rahasia IE
Dapatkan lebih banyak
rahasia IE dengan mengutak-

utik registry pada Internet Explorer.

ChemSketch
Menggambar
molekul kimia
menjadi amat

mudah dengan template
maupun free-hand.

Gambar anda seolah dapat direaksikan.

Animasi 3D
Animasikan rumus molekul
anda dengan ADC/3D Viewer.

Canggih tapi sangat mudah!

8

46

48

Pine: Emailnya Unix
Unix shell account memberi email
account dengan Pine.

30

Telnet untuk Email
Gunakan telnet untuk email
secara manual.

28

Password Cracking (2)
Setelah dikenali sifat proteksinya,
ubah program itu langsung pada

kode mesinnya dengan hex editor.

26

Password Cracking (1)
Pelajari program sasaran
dengan Disassembler

Software Cracking
Memperkenalkan metode,
tools, dan langkah-langkah

logis dalam meng-crack software.

21

Tweening pada Flash
Tweening berasal dari kata
between in  dan menjadi fasi-

litas melakukan animasi pada Flash

ASPEdit 2001
Cara mudah mempelajari ASP
dengan ASPEdit 2001

File ASP yang Pertama
Dengan ASPEdit membuat
script-script ASP menjadi sangat

mudah. Ciptakan file ASP pertama anda.

JavaScript & DHTML
Mulai membuat file JavaScript
sendiri untuk DHTML anda.

14

16

18

20

Situs NeoTek www.neotek.co.id
neotek.kpone.com.sg

Jadikan situs NeoTek sebagai pangkalan Anda berselancar

Link Langsung
Kunjungi situs-situs yang dibahas di
majalah NeoTek dengan sekali klik
lewat situs NeoTek.

NeoTek versi PDF
Kehabisan NeoTek di kota Anda?
Dapatkan saja versi PDF-nya. Gratis!

Download
Tersedia juga download di situs
NeoTek selain dari situs aslinya

Layanan Rupa-rupa NeoTek
Dapatkan perlengkapan awal dalam
berinternet dari situs web NeoTek
HumanClick
Hotline langsung ke redaksi NeoTek
untuk menyampaikan saran dan pesan.
Chat Room
Kini tidak usah jauh-jauh untuk ngobrol
langsung dengan sesama NeoTeker
Mailing List
Ini yang paling ramai. Segera ikutan
berbagi pengalaman berinternet!

24

NeoEduNeoEdu
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Gnuchess & Winboard
Gunakan Winboard sebagai
interface grafis papan catur

dan gnuchess sebagai chess engine-
nya. Pada X Windows cobalah Xboard.

44

Memahami Linux
Apakah Linux itu. Apa bedanya
dengan Unix? Apa pula hubung-

annya dengan GNU open source?

32

Unix Shell Gratis
Unix shell dapat dipakai untuk
memainkan gnuchess. ZOC

Terminal Emulator untuk upload.

42

Armed Linux
Install Linux langsung lewat
Windows tanpa harus memu-

singkan penyiapan partisi terlebih dulu.

Cygwin:
Unix Look and Feel
Bawa lingkungan Unix pada

Windows anda. Bukan hanya look and
feel  tetapi juga ciptakan utilitas-utilitas
Unix yang ada dari source code-nya.

Cygwin: Makefile
Mempelajari command line
Unix sambil meng-unzip source

dode untuk kemudian dikonfigurasi dan
diciptakan file .exe-nya

Cygwin: Gnuchess.exe
Membentuk gnuchess.exe yang
dapat dimainkan langsung

melalui command line Unix pada Cygwin.

34

36

38

40

Daftar Isi

NeoProfil

NeoTek Februari 2002

Database pada WAP
Aplikasi database ASP pada WAP pada
Windows 98 dengan menggunakan
browser M3Gate, Notepad, Access
2000, serta Personal Web Server.

Tweaking: Apa Itu?
Selain TweakUI dan Winhacker, kini
terdapat pula CaroX, suatu tweaking
tool buatan rekan NeoTeker.

Linux Tutorial 
Onno W. Purbo memperkenalkan
Samba serta Office yang dijalankan
pada Linux.

Kru NeoTek
Bermarkas di
Gedung Cahaya Palmerah 503
Jl. Palmerah Utara III No. 9
Jakarta 11480
Telp. 021-5481457
Fax. 021-5329041

Bank
Bank BNI
a.n. PT NeoTek Maju Mandiri
No. rekening 070.001709720.001

Bank BCA KCP Rawamangun
a.n. Aswan Bakri
No. rekening 0940544131

Percetakan
CV Angkasa Bandung

Kulit Muka
M. Hadi Fr.

Pemimpin Umum
Fachri Said

Pemimpin Redaksi
Kosasih Iskandarsjah

Redaktur Ahli
Onno W. Purbo
Michael S. Sunggiardi

Pemimpin Usaha
Fahmi Oemar
Ridwan Fachri

Redaktur Pelaksana
Gianto Widianto
Dadi Pakar

Sekretaris Redaksi
Elvy Risma Nainggolan

Dewan Redaksi
Suprianto
Pemasaran
Hedhi Sabaruddin
Tuti Sundari

Sirkulasi
Bangun
Keuangan
Aswan Bakri
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FOKUS BULAN INIFOKUS BULAN INI

NmN
Neoteker menjawab Neoteker
dalam forum milis NeoTek

Ada Apa di CD NeoTek?
Linux dan Unix di Windows
Cracking Tools
Flash dan SWiSH Installer

Daftar Isi CD NeoTek
Graphics Tool Redaksi NeoTek
Program Umum Berselancar
ChemSketch dan Pelengkapnya

NeoRagam

Inbox

Software CrackingSoftware Cracking
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NeoRagam

AdaAda ApaApa didi CCDD NeoTNeoTek?ek?
CD NeoTek bulan ini terutama memuat jenis-jenis Linux yang dapat diinstal
langsung melalui Windows tanpa harus memikirkan partisi terlebih dahulu.
Dapatkan juga berbagai tools untuk software cracking.

CD NeoTek
Januari 2002

ada Januari 2002
(Vol II No. 3), ini
NeoTek kembali

secara terbatas menyajikan
majalah bersama CD.

Kali ini CD NeoTek berisi
software-software ukuran
besar yang kiranya akan
sulit untuk di-download
sendiri, di antaranya Armed
Linux, Cygwin, GNU Chess
source code, dan Personal
Web Server.

PWS bersama ASPEdit
dimuat lagi pada CD kali
ini karena ada bahasan
khusus mengenainya.

Kali ini NeoTek tidak me-
nyertakan hacking tools,
melainkan tools untuk soft-
ware cracking. Software
cracking dibahas di NeoTek
untuk memberikan wawas-
an mengenai cara kerjanya
serta untuk mendorong
minat belajar pemrogram-
an lebih lanjut, terutama
assembly language.

Banyaknya minat terhadap
CD NeoTek membuat versi
majalah dengan CD dinaik-
kan tirasnya menjadi 3000
eksemplar.

Majalah dengan CD dapat
diperoleh di toko-toko
buku besar di kota anda
atau langsung ke kantor
NeoTek di Jakarta.

uArmed Linux
Armed Linux Beta 1.0
Workstation. Diinstalasi
menggunakan Windows
installer dan dijalankan
melalui DOS prompt. Da-
patkan X Windows serta
Netscape, WinAmp, dan
GIMP for Linux. Tidak
berjalan pada Windows  ME.

uCygwin
Mengemulasi Unix dibawah
Windows. Memungkinkan
pemakai Windows menda-
patkan look and feel  serta
utilitas-utilitas Unix.
uGNUChess
Source code GNUChess da-
lam bentuk terkompresi
chess-5.02.tar.gz, yang da-
pat anda kompilasi menjadi
file .exe baik pada emulasi
Unix Cygwin maupun pada
Armed Linux.
uWinboard 4.2.3.
Jadikan GNUChess anda
chess engine yang menja-
lankan interface grafis
Xboard (pada Linux) atau
Winboard (pada Windows).

uGIMP for Windows
Aplikasi grafis yang paling
populer di Linux kini tersedia
pula pada Windows. Software
saingan Photoshop yang ta-
dinya hanya ada di Linux.
uChesspad/Crafty
uThat Game Chess
Permainan catur lain yang
berjalan pada Windows.

uWin32Dasm
Disassembler untuk meng-
urai suatu program ke kode-
kode assembly-nya.

uHiew
Hacker s View, tool yang
mampu mengubah file
langsung lewat kode-kode
heksadesimalnya. Versi
demo ini tidak bisa untuk
editing.

uHiew_v6.76
Crack untuk mengubah
Hiew versi demo menjadi
full version-nya.

uSweet Little Piano
Contoh software yang
dilindungi oleh password
sebagai sasaran cracking.

uSoftICE 4.05
Advanced Windows debug-
ger untuk melihat, eksplo-
rasi, dan men-debug file exe,
dll, dan device driver. Digu-
nakan untuk serial fishing.

uSoftICE 2.80
Versi lama SoftICE. Hanya
berjalan pada DOS.

SoftICE Tools
uSoftICE Tools Pack
uIce Patch 2.0
uIce Dump 6.021
uFrogsICE 1.08.9

uWinHex 9.72
Hexadecimal editor untuk
file, disk, dan RAM dengan
banyak fitur yang mudah
digunakan. Kebutuhan
hardware-nya minimum.

PP

LINUX DAN UNIX DI WINDOWSLINUX DAN UNIX DI WINDOWS

CRACKING TOOLSCRACKING TOOLS
uFlash 5 Installer
uSWiSH 2.0
Versi trial yang berfungsi
selama 30 dan 15 hari.

Graphics Tools
uConversion Artist
uPICPress
Software untuk screen cap-
ture, konversi format grafik,
manipulasi grafik, sampai
separasi warna.
uChemSketch 5.0
Membuat rumus molekul
menjadi begitu mudah de-
ngan menggunakan template
yang ada. Dapat dikonversi
ke bitmap maupun 3D viewer.

uASPEdit
Editor ASP yang sangat
mempermudah pemben-
tukan script ASP.

uPersonal Web Server
Server gratis Microsoft un-
tuk menjalankan script ASP.

uZOC 4.0.3.
Terminal emulator untuk
telnet maupun upload dan
download file.
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daftar isi cd neotekdaftar isi cd neotek Graphics Tool Redaksi NeoTek
uConversion Artist

Software ini sudah tidak tersedia
lagi di Internet, tetapi tetap me-
rupakan utulitas grafis yang amat
berguna dan praktis, mengingat
ukurannya yang kecil dan tidak
memerlukan instalasi khusus ke
registry.
Selain screen capture (seluruhnya
atau sebagian), software ini juga
mampu memanipulasi gambar
seperti cropping, scaling, mau-
pun mengatur kecerahan dan
kejenuhan warna.

Mampu juga mengurai warna menjadi empat komponen
CMYK (cyan, magenta, yellow, dan black). Anda kini mem-
punyai mesin separasi warna sendiri di komputer anda!

uPICPress
Reinkarnasi dari Conversion
Artist. Kini menjadi software
komersial yang versi evaluasi-
nya ini hanya mengizinkan 20
kali saving.
Fungsi-fungsinya persis sama
dengan Conversion Artist yang
freeware itu. Bahkan posisi
menunya pun tidak berubah! Bandingkan juga kedua soft-
ware di atas dengan Adobe Photoshop. Ringannya kedua
software ini membuatnya praktis untuk kerja grafik yang
cepat. Termasuk menyiapkan majalah anda ini.

Hlm.Nama FileNama Program

3D ISI Viewer
ACD Mol X
ACD/I-Lab
Armed Linux
ASPEdit
ChemBasic
ChemDraw Extension
ChemSketch
Chesspad
Conversion Artist
Cygwin
Flash 5 Trial
Frogs Ice
GIMP
GNU Chess source code
Hacker s View
Ice Dump
Ice Patch
Name ISIS
Personal Web Server
PICPress
Soft Ice Tools pack
SoftICE 2.80 DOS
SoftICE 4.05 Windows
Spectral Viewer
Structure Draw Applet
Sweet Little Piano
SWiSH 2.0 Trial
That Game Chess
Winboard 4.2.3
Windows 32 Disassembler
WinHex
ZOC Terminal Emulator

3disis45
acdmolx
ilab50
armwbk11
aspedit
chembas
cs_int50
chemsk50
0202
cnvart
setup
flash5-trial
frogsice
gimp-setup-2001
chess-5.02.tar.gz
hiew
id6021
icepatch
nameisis50
setup
pp35
sitools
sidos-28
si405w9x
spview50
sda130
swlipi32
Swish 2.0
chess
winboard-4_2_3
wdasm893
winhex
zoc43_win_english

48
48
48
34
16
48
48
46
45
5

36
14
22
4

38
24
22
22
48
19
5

22
22
22
48
48
24
10
45
44
24
27
30 ChemSketch dan PelengkapnyaChemSketch dan Pelengkapnya

Program Umum BerselancarProgram Umum Berselancar

Internet Explorer 6
Real Player 8 Basic
Quick Time
Windows Media Player 7.1
Adobe Acrobat Reader
Winzip 8.1

Cute FTP
WS_FTP
ICQ 2000a Beta
mIRC
Go!Zilla
WinAmp 2.75

uChemSketch 5.0
Software grafik untuk rumus
molekul. Gambar molekul
dengan bantuan template
ataupun cara bebas. Ekspor
ke bitmap dan amati dengan
3D viewer.

uACD/I-Lab Add-on
Untuk koneksi internet ke
database kimia. Digunakan
di universitas-universitas
AS, termasuk Stanford.

uACD/MolX Ctrl for I-Lab 
ACD/MolX Control me-
mungkinkan menggunakan
ActiveX control, bukannya
Java applet untuk melihat
dan mengedit struktur kimia.

uChemBasic
Bahasa pemrograman da-
lam Basic untuk menyusun
struktur kimia!

uName ISIS dan 3DISIS
Penamaan IUPAC dan 3D
viewer untuk ISIS Draw
dan ISI Base dari MDL.

uSpecViewer
Mengamati berbagai jenis
spektra lewat satu program.

uChemDraw Extension
Integrasi ke ChemDraw
dari CambridgeSoft.

uStructrure Drawing
Applet 1.30
Fungsi ACD/I-Lab yang
platform independent. Da-
pat digabungkan dengan
kode-kode HTML, query ke
database dan menampilkan
hasilnya.



6 NeoTek Januari 2002

Inbox

Forum ini dimaksudkan sebagai bentuk offline dari mailing list
NeoTek di http://groups.yahoo.com/group/majalahneotek.

NmNNmN
NeoTeker menjawab NeoTekerNeoTeker menjawab NeoTeker

Linux di notebook
T: Posted November 2
Kalau sweeping PC ke ru-
mah-rumah kemungkinan-
nya kecil, tapi untuk note-
book computer kemung-
kinan razia di perjalanan
tampaknya lebih besar.
Pertanyaannya adalah:
1. Apakah Linux dapat di-

instal di notebook? 
2. Kang Onno, Mandrake

bisa jalan di notebook
tidak?

3. Kalau ya, kebutuhan mi-
nimumnya (prosesor,
memory, space, dll.) apa
saja?

4. Apakah StarOffice bisa
jalan pada Windows?
dan StarOffice itu
freeware bukan?

5. Saya dengar ada CD
khusus driver2 untuk
Linux agar bisa menge-
nal hardware lebih
banyak?

Purwanto Soemarto

J: Posted November 2
1. Bisa banget ...
2. Saya pasang di Toshiba

Tecra 8000 saya, bisa
jalan. Kalau mau cek
coba cek dulu ke
www.mandrake.com.
Lihat di situ apa yang
perlu dilakukan.

3. Tecra 8000 rasanya
Pentium II 233MHz
deh. Memory 32Mbyte.
Space minimal sekitar
3Gbyte-an gitu yang
enak buat kerja.

4. Betul StarOffice ada
binary buat Linux,
Windows dll. Ya, Star-
Office freeware

5. Saya biasanya ambil di
Internet

Onno W. Purbo
onno@indo.net.id

Membuat file PDF
T: Posted November 5
Kalo create file yang ber-
ekstension *.PDF pake apa
yach. Soalnya saya sering
download dari Internet
yang berekstension PDF
selama ini yang saya bisa
cuma read aza pake
Acrobat reader
Syafdi Awarman

J: Posted November 5
Pakai Adobe Acrobat. Kalau
Adobe Acrobat di-install dari
CD-nya, akan terinstalasi
bukan hanya Acrobat Read-
er, melainkan juga Acrobat
Distiller.

Acrobat Distiller ini akan
berperan sebagai virtual
printer. File yang akan kita
buat file .PDF-nya (baik itu
dari Word, Quark XPress,
ataupun Page Maker) kita
print. Waktu print pilih
printernya Acrobat Distiller.
Hasil ’cetakannnya’ adalah
file .PDF ini.

Cara lain (juga pakai Adobe
Acrobat) adalah mengubah
file tadi menjadi file .EPS
(encapsulated postscript),lalu
file .EPS ini diubah lagi jadi
.PDF (portable document
format).

Adobe Acrobat kini sudah
versi 5.0. Harus beli CD-
nya; tidak bisa download
dari Internet, sebab yang
gratis cuma Reader-nya.

Kosasih Iskandarsjah
kosasih_iskandarsjah@yahoo.c
om

Dial-up dengan
account orang lain 
T: Posted November 5
Mau nanya nich, misalnya
kalau kita tahu Password
dial-up account orang lain,
dan kita gunakan untuk

meng-access internet tapi
menggunakan komputer
kita sendiri, nomor tele-
phone sendiri, dari rumah
kita, kira-kira bisa dilacak
nggak sih oleh yang pu-
nyanya siapa yang dengan
ilegal memakai dial-up
accountnya...?

Yulianto

J: Posted November 5
Kalau ISP-nya cukup
pandai bisa dilacak. Engga
susah koq ..
Onno W. Purbo
onno@indo.net.id

J: Posted November 4
Tentu saja bisa karena di
ISP ada daftar member
yang login atau dialup dari
beberapa nomor pelang-
gannya, secara langsung si
member yang sah dapat
mencek sudah berapa jam
dia akses ke internet di
sertai dengan nomor dial
asal koneksinya....seperti
pernah teman saya lakukan
mencoba  account saya
ketika saya terdaftar di ISP
CBN teman saya menggu-
nakan 7 jam akses dengan
account dan password CBN
saya di rumahnya,
nahhhh lho....:)
Foryanto J. Wiguna
bizzcomtech@yahoo.com

Cari CD NeoTek
T: Posted November 5
Ternyata nyari CD neotek
sulit banget. saya udah cari
di Gunung Agung, Kharis-
ma, TB utama, yang ada
cuma majalahnya doank.
Bung Redaksi sebetulnya
CD tsb dijual di toko-toko
apa nggak? Atau harus
contact ke Redaksi ?
˙ k r a b i R w ˜
digitalchandra@yahoo.com

J: Posted November 5
CD NeoTek sampai NeoTek
November 2001 memang
hanya dapat diperoleh di 
redaksi NeoTek di Jakarta.
Harganya Rp15.000,- dengan
ongkos kirim Rp5000,-
Mulai Desember 2001 (Vol
II No. 3) akan ada dua versi
NeoTek. Majalah saja
(Rp9.500,-) dan Majalah
pakai CD (Rp19.500,-).
Yang pakai CD sementara
hanya akan didistribusikan
terutama untuk toko buku
Gramedia, langganan, dan
perwakilan. Penjualan
umum ke agen majalah
masih yang versi tanpa CD.
Versi yang pakai CD juga
masih akan sangat terbatas
distribusinya (1000 sampai
2000 set saja).
Mulai edisi Desember ini
harga CD (saja) jadi
Rp10.000,- dengan ongkos
kirim Rp5000,-
Kalau memang CD
diperlukan, maka bertahap
versi dengan CD akan
diproduksi lebih banyak.
Onno W. Purbo
onno@indo.net.id

Hard disk sering down
T: Posted November 6
Kenapa ya, harddisk
komputer saya sering
down (mati mendadak),
saya cek kabelnya OK,
apakah harddisknya kurang
bagus kali ya.
EPHI VAN LIN
ephi_vl@yahoo.com

J: Posted November 6
Apa power management di
Windowsnya diaktifkan
untuk mematikan harddsik
pada jangka waktu tertentu.
Skinner
step2k@telkom.net
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3 DAFTAR MELALUI SITUS MILIS
NEOTEK
Bila anda mendaftar melalui situs
kami, maka anda harus melakukan
registrasi dulu di Yahoo Groups ini.
Untuk itu cari dan klik Register.
Selanjutnya ikuti perintah yang
diberikan  oleh situs tersebut.

nda baru mulai ber-Internet?
Langkah awal adalah
mendapatkan alamat email.

Sudah? Selanjutnya ikutan menjadi
anggota milis (mailing list) agar anda
bisa bertanya pada para ahlinya.
Memang tidak semua milis cocok buat
pemula, tetapi milis NeoTek pasti cocok
untuk anda karena diskusinya tidak
terlalu berat. Selain itu, di sini juga ada
pakarnya Internet yaitu Bapak Onno W.
Purbo yang sangat rajin menjawab
pertanyaan yang muncul.

Tunggu apa lagi? Buruan gabung!
Tutorial di bawah ini menguraikan cara
bergabung dengan milis NeoTek,
langkah per langkah.

IIKKUUT MAIT MAILILINNG LIG LISSTT
BBIAR TIAR TAMAMBBAH PAH PIINNTTAR AR 
BBEER-IR-INNTTEERRNNEET RT RIAIA
Bagi anda yang masih belum tahu caranya ikutan mailing list
NeoTek, tutorial berikut ini ditulis untuk anda. Kami berpen-
dapat, selalu ada teman yang baru ber-Internet dan karena
itu NeoStart ini khusus buat anda para newbies.

A

DAFTAR MELALUI EMAIL
Cara kedua adalah dengan
mengirimkan email kosong ke
majalahneotek-
subscribe@yahoogroups.com
melalui Web email atau POP email
yang anda miliki. 

KETIK PESAN BARU ANDA
Jika anda menggunakan langkah
3, maka cara mengirimkan pesan
melalui milis NeoTek juga tersedia
yaitu dengan mengklik menu
Post. Selanjutnya ketik pesan dan
klik menu Send di bawahnya.

MASUK KE SITUS NEOTEK
Arahkan browser anda ke situs
NeoTek di www.neotek.co.id atau
neotek.kpone.com.sg. Lalu cari
dan klik  Menu Mailing List di
kolom kiri halaman awal.

CARA MENDAFTAR
Ada dua cara mendaftar ke Mailing List
NeoTek yaitu melalui situs milis kami:
http://groups.yahoo.com/group/
majalahneotek dan melalui
pengiriman email kosong ke alamat
majalahneotek-subscribe
@yahoogroups.com

1

4 5

2

Milis NeoTek: http://groups.yahoo.com/group/majalahneotek

IKUTAN MENJAWAB PESAN
YANG MUNCUL
Setiap anggota boleh bertanya
atau menjawab pertanyaan yang
diajukan anggota lainnya. Keaktifan
anda diharapkan di sini. Bila anda
ingin menjawab, klik Replay lalu
ketik pesan dan segera klik Send.

6
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Ingin menghilangkan nama ISP dari Internet Explorer atau mengubah mesin
pencari default pada browser? Selami Registry dan anda akan terkejut jika
mendapatkan banyaknya fitur yang tidak anda inginkan dapat anda ubah.

NGIN MENGUBAH CARA
BROWSING? Di dalam Internet
Explorer terdapat belasan

setting yang menentukan cara IE
bekerja dan anda sebenarnya dapat
mengubahnya. Ada setting yang da-
pat anda ubah pada Windows Explor-
er serta pada berbagai Control Panel
yang akan mempengaruhi cara anda
memandang situs Web. Lalu bagai-
mana Windows dapat menelusuri
semua itu?  Jawabnya adalah dengan
menggunakan Registry  basis data
dari semua setting konfigurasi pada
komputer anda.
Jika anda pernah mengubah sebuah
setting pada IE tetapi ternyata IE
kembali pada keadaan awalnya ketika

anda menggunakannya kembali, ma-
ka kemungkinannya adalah anda
mengubah setting yang ada duplika-

sinya di Registry. Dengan memberi
tanda cek pada suatu boks atau de-
ngan memilih radio button pada

Menggunakan Registry untukMenggunakan Registry untuk

Mengatur IEMengatur IE

•

I

•

JIKA KOMPUTER ANDA digunakan
bersama beberapa orang lain, an-
da mungkin perlu mengunci be-
berapa setting pada IE untuk me-
lindungi set-up anda. Pengubah-
an setting Security Zone pada Re-
gistry tidak akan banyak artinya
karena anda dapat melakukannya
dengan menggunakan kotak dia-
log sederhana pada IE, tetapi jika
anda ingin mencegah agar orang
lain tidak dapat mengubahnya,
atau jika anda hanya ingin semua

orang mempunyai setting yang
sama, bukalah Registry. Key yang
anda perlukan adalah HKLM\
Software\Microsoft\Windows\Cur
rentVersion\Internet Settings dan
juga HKCU\Software\Microsoft\
Windows\CurrentVersion\Internet
Settings. Untuk hanya melindungi
setting pada komputer lokal, buat
key-nya, HKLM\Software\Policies\
Microsoft\Windows\CurrentVersion
\Internet Settings Security_HKLM_
Only dengan nilai DWORD 1. Jika

anda tidak menginginkan peru-
bahan apa pun pada seluruh
setting, gunakan HKCU\Sotware\
Policies\Microsoft\Internet
Explorer\Restrictios\NoBrows
Options\ dengan nilai DWORD 1.
Hal ini akan menghilangkan link
Internet Options dari menu Tools.

Anda dapat menon-aktifkan opsi
seperti klik kanan untuk context
menu dengan membuat key di
bawah HKCU\Software\Policies\

Microsoft\Internet Explorer\
Restrictions. Yang paling berguna
adalah NoBrowserContextMenu -
untuk menonaktifkan context
menu dan NoSelectDownloadDir
untuk memastikan bahwa file
yang di-download selalu masuk
ke direktori download standar.
Kembali, buat key-nya sebagai
DWORD dengan satu nilai 1 dan
tempatkan di pohon HKLM agar
berlaku untuk semua pengguna.

MMengunci Mengunci settingsetting Internet ExplorerInternet Explorer
MELINDUNGI SETTING
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Tools → Internet Options, anda telah
mengubah satu key Registry, tetapi
jika ada tiga atau empat key dengan
setting terdahulu, maka satu-satunya
cara untuk menghentikannya agar
tidak muncul kembali adalah dengan
mengubah Registry secara manual.

Mencari key
Di Registry terdapat beberapa setting
yang tidak dapat diubah dari kotak
dialog mana pun di dalam Windows
atau Internet Explorer. Dan jika anda
pernah menginstal PowerToy, suatu
bar pada Explorer, atau suatu plug-in
yang menambahkan perintah ekstra
pada IE, anda mungkin perlu mem-
buka Registry untuk mengetahuinya,
bagaimana cara kerjanya, dan kadang
bagaimana cara menghilangkannya.

Tetapi upaya untuk menemukan key
yang anda inginkan pada Registry
mungkin akan jauh lebih sulit ketim-
bang memunculkan kotak dialog un-
tuk mengubah setting dari dalam IE
sendiri. Kesulitan ini timbul sebagian
karena cara penataan Registry itu.
Registry menyimpan informasi dalam
enam cabang hierarkis (hierarchical
branch); dua di antaranya menyim-
pan informasi mengenai perangkat
lunak PC anda dan satu mengontrol
cara kerja Windows dengan berbagai
jenis file berbeda. Nah, tiga cabang
lainnya-lah  yang berisi key yang
mengatur setting untuk IE. Jika Win-
dows anda telah diatur untuk digunakan
oleh beberapa pengguna, HKEY_USERS
(disingkat HKU) menyimpan prefe-
rensi untuk setiap orang; anda dapat

mengakses setting tersebut untuk
pengguna yang sedang mengguna-
kannya pada cabang HKEY_ CUR-
RENT_USER (HKCU); sementara
setting yang berlaku untuk semua
pengguna disimpan pada cabang
HKEY_LOCAL_ MACHINE, di
dalam HKLM\ Software\Microsoft\
Internet Explorer. Jika pengubahan
suatu setting pada HCKU tidak meng-
hasilkan apa yang anda inginkan,
anda juga dapat mengeceknya di sini.
Hemat waktu anda dengan mencari
Registry untuk key lain dengan
nama yang sama setiap kali anda
membuat perubahan.
Karena IE amat terkait erat dengan
Windows, demikian juga setting di
bawah HKCU\Software\Microsoft\
Internet Explorer\ maka anda

Jika anda ingin menentukan home-
page, atau ’start page’ anda, akan jauh
lebih mudah menggunakan Internet
Options ketimbang Registry, tetapi jika

pengguna yang berbeda mempunyai start
page berbeda, maka anda dapat
melihatnya pada key HKEY_USERS.

Driver semacam Adaptec CD Creator
pun pun menyimpan setting-nya pada
Registry.

Pada Registry anda dapat mengubah
lebih banyak opsi untuk cara kerja
pencarian IE ketimbang jika anda
melakukannya lewat bar Search.

Di sini anda dapat menghapus hanya
satu URL dari History, ketimbang
membersihkan semua URL.

Banyak key di Registry dapat ditemu-
kan setting-nya pada tab Advanced 
tetapi lebih banyak lagi key yang tidak
ada di sini.

1 2

3

4

5

Kapan sebaiknya menggunakan Registry
CARA YANG BENAR

MENGUBAH SETTING PADA KOTAK DIALOG IE MEMANG LEBIH MUDAH, TETAPI KADANG SATU-SATUNYA JALAN MEMBUAT
PERUBAHAN PADA SETTING ANDA ADALAH LEWAT REGISTRY

1

5

4
3

3
2



mungkin perlu melihat di HKCU\
Software\Microsoft\Windows\Explor
er dan di HKCU\Software\Microsoft\
Windows\Internet settings\ juga.

Hati-hati
Sebelum anda menggarap Registry,
jangan lupa bahwa Registry menyim-
pan setting yang mengontrol cara
kerja Windows. Ikuti petunjuk pada
NeoTek Vol. II, No. 3, Desember 2001
mengenai cara mem-back-up Regis-
try sebelum anda mulai meng-oprek
Registry, dan sebelum anda membuat
perubahan apa pun pastikan anda
mencatat setting aslinya. Anda akan
memerlukan catatan itu jika perubah-
an yang anda lakukan menimbulkan
efek samping yang tidak dikehendaki.
Cara tercepat untuk menghilangkan
atau mengubah suatu key atau nilai
adalah dengan mengklik tombol ka-
nan mouse dan memilih Delete atau
Modify; klik-kanan pada tempat ko-
song pada bagian bawah layar untuk
menambahkan sebuah key atau nilai
baru dengan cepat. Dan jangan meng-
harapkan akan adanya perubahan
seketika; anda perlu menutup dan
membuka kembali IE atau bahkan
me-restart Windows untuk melihat
perbedaannya.

Mencari dengan cara sendiri
Mengetikkan kata kunci (keyword)
pada bar alamat IE memang bagus
untuk melakukan pencarian yang ce-
pat, tetapi anda mungkin tidak ingin
menggunakan mesin pencari MSN
yang ditawarkan Microsoft. Anda da-
pat menginstal PowerToy yang me-
mungkinkan anda mengetikkan ’av’
untuk mencari dengan Alta Vista atau
menginstal toolbar Google, tetapi jika
anda selalu ingin menggunakan Northern
Lights atau WebTop, mengapa anda
harus selalu menghapal untuk me-
ngetikkan kata kunci lain?
Pada IE4 anda dapat mengubah
HKCU\Software\Microsoft\Internet
Explorer\SearchUrl\Default\ pada
URL mesin pencari favorit anda
(gunakan http://www.altavista.com.
cgi-bin/query?q=%s untuk Alta
Vista; atau http://www.google.com/
searchq=%s untuk Google). Hal ini
tidak berlaku pada IE5, tetapi anda
dapat mengubah search bar yang
muncul pada saat anda mengklik
tombol Search atau memilih Start →
Find → ’On The Internet.’ Ubah nilai
Search Page dan Search Bar pada
HKCU\Software\Microsoft\Internet
Explorer\Main\ menjadi URL yang
anda ingin gunakan, tetapi pilih me-
sin pencari dengan search bar yang

seharusnya karena jika tidak halaman
Web yang anda cari mungkin tampil
search bar bukan di window utama.
Ini mungkin tidak berlaku jika nilai
DWORD 0 pada HKCU\Software\
Microsoft\Internet Explorer\Main\
Use Custom Search URL. Jadi ganti

nilai tersebut menjadi 1. Mungkin
akan lebih mudah jika anda meng-
gunakan metasearch bar InfoGrid
(dapatkan dari www.infogrid.com/
homepage.htm.)
Jika anda menginginkan tombol
Search membawa anda langsung ke

NeoStart
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JIKA ANDA MEMPEROLEH IE
dari ISP anda, bukan dari
situs Web Microsoft,
browser anda itu mungkin
akan berhias kalimat se-
perti ’Provided by ISP Anu.’
Jika merasa terganggu,
anda dapat menghilang-
kannya atau bahkan me-
nambahkan judul anda
sendiri pada window itu.
Anda juga dapat mengubah
logo berputar yang terle-
tak di pojok kanan atas
serta memperamai tam-
pilan IE dengan menem-
patkan bitmap sebagai la-
tar belakang toolbar anda.
Judul window browser
anda diatur di HKCU\
Software\Microsoft\Intern
et Explorer\ atau HKLM\
Software\Microsoft\Intern
et Explorer\Main. Untuk
menghilangkan nama pa-
da window itu, cari se-
buah key bernama Win-
dow Title lalu hapus atau
ubah teksnya dengan judul
anda sendiri.
IE menggunakan logo yang
berputar agar anda tahu
bahwa IE tengah sibuk
memuat halaman Web dan
sebuah logo lain setelah-
nya. ISP kerap membajak
logo ini, tetapi anda dapat
mengembalikannya atau
menggunakan gambar
sendiri. Untuk menggu-
nakan logo animasi yang
standar, hapus key Brand-
Bitmap dan SmBrand-

Bitmap pada
HKCU\Software\
Microsoft\Internet Explor-
er\Toolbar dan untuk
kembali ke logo standar
yang tidak bergerak, ha-
pus SmallBitmap dan Big-
Bitmap. Jika tidak dapat
menemukan key-key ini,
anda sebaliknya dapat
mencarinya pada pohon
HKLM.

Membuat logo sendiri
Jika anda ingin menggu-
nakan image anda sendi-
ri, anda memerlukan dua
ukuran, 22 x 22 piksel
dan 38 x 38. Untuk setiap
ukuran, anda memerlukan
sebuah image sebagai lo-
go yang tidak bergerak dan
image dengan potongan-
potongan vertikal untuk
logo bergerak sehingga
untuk sebuah ikon besar
dengan sepuluh frame
anda memerlukan sebuah
image dengan lebar 38
piksel dan tinggi 380 pik-
sel. Empat image pertama
digunakan pada saat IE
mulai browsing sedang-
kan setelahnya bergerak
berputar sampai halaman
Web tersebut selesai di-
muat. Anda perlu mem-
buat atau mengubah key
BrandBitmap, SmBrand-
Bitmap, SmallBitmap, dan
BigBitmap untuk merujuk
pada nama file image-
image anda.

Anda dapat menggunakan
image bitmap apa saja
untuk latar belakang
toolbar IE  pilih image
yang dapat tersusun (tile)
dengan baik sehingga
tidak akan terlihat sam-
bungan-sambungannya
ketika anda harus menye-
suaikan ukuran (resize)
window-nya. Di bawah
HKCU\Software\Microsoft
\Internet Explorer\Toolbar
buat sebuah nilai baru
bernama BackBitmapIE5
(cukup ’BackBitmap’
untuk IE4) dan isi path ke
direktori gambar itu. Un-
tuk menghilangkan image
itu, yang anda perlu laku-
kan adalah menghapus
key itu.
Anda dengan mudah da-
pat mengubah font yang
anda gunakan untuk me-
lihat halaman Web dan
anda dapat membuat teks
lebih besar atau lebih
kecil dengan mengubah
View → Text size, tetapi
jika anda ingin mengubah
ukuran font atau format
yang digunakan untuk
style HTML standar,
masuklah ke HKLM\
Software\Microsoft\Intern
et Explorer\Styles. Guna-
kan Bold atau NoBold,
Italic atau NoItalic dan
Underline atau
NoUnderline dan ubah
ukuran font-nya.

SENTUHAN AKHIR

Mengubah tampilan Internet ExplorerMengubah tampilan Internet Explorer

• Microsoft bukan hanya menentukan home-
page bagi anda, tetapi menguasai juga se-
tiap halaman dengan logonya.

• Anda dapat mengubah ukuran font dan
memformat untuk style HTML standar, jadi
bukan hanya memilih tipe huruf alternatif.



mesin pencari favorit anda, bukan
membuka search bar, pertama klik
tombol Search lalu pilih Customize
pada search bar selanjutnya pilih ’Use
one search service for all of these
services.’ Pilih situs search mana saja
jika yang anda inginkan tidak ada di
sana, lalu jalankan Registry Editor
dan masuk ke HKCU\Software\
Microsoft\Internet Explorer\Main\
Search Bar\ dan isi URL mesin
pencari yang anda inginkan.
Jika anda mencari PowerTool dan
ingin menambahkan sebuah mesin
pencari baru pada daftarnya, pikirkan
kata yang terdiri dari dua huruf yang
cocok lalu buat key baru di bawah
HKCU\Software\Microsoft\Internet
Explorer\SearchUrl\ dan isikan URL-
nya.

Download dan FTP
Anda dapat meminta IE agar tidak
memunculkan kotak dialog setiap kali
selesai melakukan donwload tetapi
jika IE masih tetap melakukannya,
buat agar HKCU\Software\Micro-
soft\Internet Explorer\Main\Noti-
fyDownloadComplete diset ke ’No.’
Jika anda meminta IE menyimpan
(save) sebuah file yang anda tengah
download, maka IE akan menyimpan-
nya pada direktori tempat anda ter-
akhir menyimpan suatu file. Jika
anda menginginkan IE selalu meng-
gunakan direktori yang sama, ubah
key HKCU\Software\Microsoft\
Internet Explorer\Download Direct-
ory agar path-nya mengarah pada
direktori yang anda inginkan. Akan
tetapi ini tidak sama dengan me-

nyimpan halaman Web karena yang
mengontrol penyimpanan halaman
Web adalah key Save Directory pada
HKCU\Software\Microsoft\Internet
Explorer\Main.
Anda mempunyai dua pilihan untuk
mentransfer file lewat FTP di Win-
dows; anda dapat menggunakan pro-
gram FTP dengan mode DOS yang
sudah built-in atau dapat juga meng-
gunakan IE. Anda dapat mengontrol
program yang mana yang akan digu-
nakan ketika anda mengetikkan
perintah FTP (seperti ’ftp ftp.micro-
soft.com.’) Jika anda menginginkan
IE yang muncul, masuk ke HKLM\
SOFTWARE\Microsoft\Windows\
CurrentVersion\URL\Prefixes\ dan
buat satu nilai string baru bernama
ftp yang berisi ftp://; jika anda meng-
inginkan program DOS yang mun-
cul, hapus key FTP-nya.
Jika anda menginginkan IE menam-
pilkan situs-situs FTP seakan sebagai
folder pada hard drive anda, ubah
HKCU\Software\Microsoft\Ftp\Use
Web Based FTP\ menjadi ’No’ untuk
tampilan folder atau ’Yes’ untuk
tampilan tradisional.

Mengubah menu
Jika anda biasa menggunakan Micro-
soft Word dan terbiasa mengatur me-
nu serta toolbar, maka daftar ikon
alternatif untuk toolbar IE tidak me-
nawarkan terlalu banyak kesempatan
untuk pengaturan interface-nya. Te-
tapi jika anda menyelam ke dalam
Registry, maka anda menyingkirkan
beberapa perintah menu yang kurang
berguna. Pada menu Help, jika anda

tidak bermaksud pindah dari IE ke
Netscape atau mengirim umpan balik
apa pun, anda dapat menghilangkan
entri-entri itu sama sekali. Masuk ke
HKCU\Software\Policies\Microsoft\
Internet Explorer\Restrictions\ (anda
mungkin harus membuat key Res-
trictions sendiri pada sistem terten-
tu). Buat key dengan nama NoHelp-
ItemNetscapeHelp, NoHelpItem-
SendFeedback, NoHelpItemTipOf-
TheDay  atau ubah key-key itu
jika sudah ada  dengan nilai
DWORD 1 untuk menghilangkan
item menu Netscape Help, Send
Feedback dan Tip of the Day. Jika
anda menginginkan hal ini berlaku
untuk semua orang yang mengguna-
kan komputer anda, bukan hanya
pengguna saat ini, tempatkan key-
key tersebut di tempat yang sama di
bawah HKLM.
Menu File juga bisa menjengkelkan;
anda cuma ingin mengklik File →
New untuk sebuah window browser,
tetapi anda harus memilih dari New
Mail, New Newsgroup Posts, New
Contacts atau Internet Phone. Jadi,
jika anda ingin menggunakan IE un-
tuk browsing, bukan untuk membuka
Outlook Express, tempatkan sebuah
policy key lain di Registry, kali ini
pada pohon Windows. Masuk ke
HKCU\Software\Microsoft\Windows
\CurrentVersion\Policies\Explorer\
dan buat sebuah key bernama
NoExpandedNewMenu dengan nilai
DWORD 1 dan IE pun akan berhenti
menawarkan opsi-opsi tambahan
tersebut.
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JAKARTA: -SARKA Agc. Jl. Tanjung Duren, -LILI SEKARWATI Agc.
Kompl. Green Ville Blok N/2,Tomang Barat. -CENTRAL KUMALA
SAKTI, Kompleks Green Ville Blok Bg/67,Tomang Barat. -AMROEL
Agc. -Bursa Media, Sunter 021-4267429  -MONAS Agc, Taman
Monas.  -PBI, Jl. Lumba-lumba , Rawamangun. -USAHA KITA Agc.
Jl.Kayumanis 7 No. 36, Matraman. -DWITAMA Agc. Cipinang
Cempedak, Oto Iskandardinata. -PIOMA Agc. Cililitan.  -YANTO
Agc. Rawamangun. -SERULING SENJA, Terminal Rawamangun. -
SIMAMORA Agc. Jl.Raya Tanjung Barat. -SITI Agc. Pondok Indah. -
UBAY Agc. Pondok Indah. -HERMAN, Jl.Raya Depok. -BURSA
BUKU,  Jl. Tole Iskandar 36,  Depok. TENGGARA INTI, Jl. Raya
Joglo No.8. -MAS Agc. Pintu Tol Bekasi Barat. -PURBA Agc.
Terminal Bus Bekasi. -DUTA HARAPAN, KCC Kalimalang Blok A/3
No.20.  -SITA Agc. Stasiun K.A Bekasi.

*Terminal Terpadu Blok M: Kebayoran: -DONA Agc. -MILU Agc. 
*Bursa Majalah Budi Utomo: -ARITONANG. -PURBAJAYA UTAMA. -

H. HITE. -H. HARUN. 
*Bursa Majalah St. Senen: -TAMORA Agc. -PURBAJAYA UTAMA. -

DAVID Agc. -LUBIS Agc, -KEDARTON Agc. 
BANDUNG: ANGKASA, Jl. Merdeka. -KAJAGA Agc. Jl.Tongkeng 3. -

GOTONG ROYONG Agc, Stasiun Bandung. -ARCHAS Agc. Jl.Buah
Batu. -DADAN ANEKA JASA, Cikapundung. -DADANG Agc.

Cikapundung. -ANTAPANI, Sukaluyu. -LIZZA Agc. Margahayu. -SITA
Agc. Jl. Suci.  YOPPI  Agc. Jl. Suci -MAJU TERUS Agc. Wastuken-
cana. -TONNY WE  Agc. Rancaekek.

CIANJUR: -RETNO ASIH Agc. -KIAT Agc. 0263-269800  -JILL’S Agc.
SUKABUMI: -KAWI Agc. Jl. RA Kosasih 477 TASIK: -DONDON
Agc. CIREBON: -CIREBON Agc.   

YOGYAKARTA: -SUMARNO Agc. Jl.Garuda, Banguntapan, Bantul
NEW KGB Agc. -PERSOJO Agc. SOLO: -BENGAWAN  Agc.

SEMARANG: -TUTI Agc. Jl. Nakula I -RAJA FOKUS Agc. -Penerbit
ANGKASA. PEKALONGAN: -KURMA Agc. CILACAP: -SEJAHTERA
Agc. KUDUS: -Shinta Agc. PURWOKERTO: -TB. ABC.

SURABAYA: -ANDI Agc. Karang Mulya IV/4, Wiyung. -TB. URANUS.
-PERMATA INTAN Agc. MADIUN: -GELIS Agc. -JASAWARTA  Agc.

BALI: -Salon VIVI Denpasar, Salon VIVI Singaraja,  -PRIMA Agc.
Denpasar. KUPANG: -TB. SEMANGAT

MAKASAR: -SELAYANG PANDANG Agc. UJUNGPANDANG: -
MAPANYUKI Agc. BANJARMASIN: -Ibu Bidan Murni.

MEDAN: -TB. OBOR. -BERDIKARI Agc. JAMBI: -TB.GLORIA.
BENGKULU: -TB.ZALDY. PALEMBANG: -MUSI & AMPERA Agc. -
WARNET NOV@NET. LAMPUNG: -LAMPUNG Agc. -Penerbit
ANGKASA. BATAM: -OTORITA Agc.

AGEN-AGEN PENYALUR MAJALAH NEOTEK
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NeoStyle

ada NeoTek Vol. II, No. 1,
Oktober 2001, kami telah
menyajikan cara membuat

animasi dengan program yang
makin digemari desainer situs Web
yaitu SWiSH. Fungsi dan fasilitas
SWiSH yang dibahas pada NeoTek
di atas adalah fungsi dan fasilitas
pada SWiSH 1.5. Sementara itu, DJJ
Holdings, pembuat SWiSH yang
beralamat di Sydney, Australia
(www.swishzone.com), meluncurkan
versi terbaru SWiSH yaitu versi
2.0. Ternyata dibandingkan versi
sebelumnya, versi 2.0 ini mempu-
nyai banyak fitur dan fungsi baru
yang belum dijumpai pada versi 1.5.

MENGENAL FITUR BARUMENGENAL FITUR BARU
PADA SWISH 2.0PADA SWISH 2.0

Kepopuleran SWiSH sebagai program pembuat animasi untuk
halaman Web makin bertambah. Pada uraian kali ini kami
memperkenalkan beberapa fitur baru yang dijumpai pada
SWiSH 2.0 dan tidak dijumpai pada versi sebelumnya, disertai
dengan langkah-langkah penggunaan fitur baru tersebut.

P

ROTATE ATAU SKEW
Klik ikon rotate atau skew pada
Layout Toolbar. Dengan fungsi
ini anda dapat memutar objek
atau membuatnya menjadi mi-
ring seperti terlihat pada gam-
bar. Letakkan kursor anda pada
titik putih dan tahan.

MOTION PATH
Berikutnya klik ikon Motion
Path. Fungsi ini digunakan un-
tuk menjalankan (move object)
dari satu tempat ke tempat
lainnya dalam satu window.

INSTALASI
Langkah awal, jalankan file
setup SWiSH 2.0 yang bisa
anda peroleh dari CD NeoTek
atau bisa anda download dari
www.swishzone.com dan ikuti
langkah instalasinya.

INTERFACE BARU
Setelah SWiSH 2.0 diinstal,
jalankan dengan mengklik dua
kali ikon SWiSH. Akan muncul
flash screen dan anda akan
masuk ke dalam tampilan
SWiSH dengan gaya baru.

1

7 8
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Pengenalan fungsi baru pada SWiSH

MEMASUKKAN TEKS
Langkah berikutnya, klik ikon
Insert Text. Kemudian ketik-
kan kata yang anda kehendaki.
Anda dapat menentukan besar,
jenis, serta warna huruf dari
kata tersebut.

INSERT CONTENT
Klik ikon Insert Content  (me-
nu di atas). Fungsi baru ini me-
mungkinkan anda memasuk-
kan berbagai jenis file kecuali
executable file untuk ditampil-
kan dalam movie anda (ter-
masuk file berekstensi .SWF).

3

9
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Untuk memperkenalkan anda dengan
fitur-fitur baru pada SWiSH 2.0,
NeoTek kali ini membahas beberapa
di antaranya.

Seperti pernah dibahas pada NeoTek
Vol. II, No. 1 di atas, SWiSH adalah
program pembuat animasi movie
yang mirip dengan Macromedia Flash,
namun bedanya bila anda mengguna-
kan Flash anda harus benar-benar
menguasai program itu, sementara
SWiSH merupakan aplikasi animasi
yang user friendly. Anda tidak perlu
mengerti secara mendalam tentang
SWiSH karena aplikasi ini menyedia-
kan toolbar dan menu yang tinggal

anda klik saja! Dengan itu anda dapat
membuat animasi yang lumayan
bagus walaupun tidak sebagus hasil
yang diberikan oleh Flash. Sebagai
contoh anda dapat melihat animasi
movie pada situs NeoTek (www.
neotek.co.id) yang menggunakan
aplikasi SWiSH. SWISH versi 2.0
disertai perbaikan pada beberapa sisi
seperti tampilan, penambahan efek
dan beberapa fungsi baru. Lewat
uraian langkah per langkah di bawah
ini, anda dapat mengikuti fungsi-
fungsi baru yang ditawarkan oleh
SWiSH 2.0 serta cara penggunaan-
nya pada animasi pembuka pada situs
majalah NeoTek.

TIP & TRIK • TIP & TRIK • TIP & TRI

SPRITE
Untuk menghemat ruang,
anda dapat menggunakan
Sprite   dan Grouping  di
dalam movie anda.

!

INSERT BUTTON
Fasilitas terbaru lainnya adalah
Insert Button. Fungsi ini efektif
bagi anda yang membuat
counter atau movie yang
menggunakan fungsi klik.

SPRITE
Selanjutnya klik Insert Sprite.
Dengan sprite, anda dapat
membuat animasi lain yang
berjalan bersamaan dengan
movie utama sehingga akan
menghemat ruang. Anda dapat
membuat lebih dari satu sprite

EFEK BARU
Kemudian pada frame 0,  klik
kanan dan pilih efek Snake
yang merupakan efek terbaru
dari SWiSH. Anda dapat meli-
hat efek ini terlebih dahulu de-
ngan mengklik ikon Play
Effect.

SUB-EFFECTS
Pada SWISH 2.0 anda diberikan
pilihan pada Effect Properties
yaitu sub-effects. Di sini anda
dapat memilih bernacam ben-
tuk animasi dari efek yang
anda pilih.

4

10 11

5 LAYOUT TOOLBAR
Yang membuat SWiSH semakin
mudah digunakan adalah fung-
si barunya yaitu Layout Tool-
bar. Di sini anda dapat memilih
berbagai macam fungsi yang
disediakan seperti zoom, rotate
dan lainnya.

EXPORT
Setelah selesai membuat movie,
anda dapat men-save file anda
atau mengekspor file tersebut.
Kini pada SWiSH 2.0 anda bu-
kan hanya dapat mengekspor
ke HTML atau SWF, namun bisa
juga ke file AVI.

6

12

! UNCODING
Pada SWiSH, anda dapat
meng-uncode sebuah file
.SWF (Flash) dengan meng-
klik File  → Open  dan
memilih file-nya.
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3 Membuat simbol
Sebelum bisa dianimasikan, tulisan
harus diubah menjadi simbol. Klik
Arrow Tool  yang terdapat pada
bagian Colors.  Klik tulisan untuk
memilihnya. Klik Insert → Convert
to Symbol  isikan name: Neotek,
lalu pilih Graphic pada bagian
Behaviour dan klik tombol OK. 

NeoStyle

lash adalah program grafis
multimedia keluaran Macromedia
yang banyak dipakai untuk

pengembangan situs web yang interaktif
dan kebanyakan digunakan untuk membuat
gambar bergerak atau animasi (lengkap
dengan suara). Karena Flash amat populer,
saat ini banyak browser yang sudah di-
lengkapi (preinstalled) dengan plug-in Flash
sehingga peselancar di Internet tidak perlu
lagi men-download player Flash untuk
menikmati animasi yang dibuat dengan
Flash.

Salah satu aspek penting dalam pembuatan
animasi dengan suatu program aplikasi
adalah kemampuan program itu untuk

MM EE NGGNGG UNAKANUNAKAN
FF UNGSI TWEUNGSI TWE EE NINI NG NG 
PADPADA FA F LL ASHASH
Flash memilik satu fitur yang amat bermanfaat saat anda
membuat animasi dengan program ini. Fitur itu adalah
tweening. Agar anda memahaminya, Siti Mutmainah
membahas penggunaan fitur ini.

F

Jalankan animasi
Motion Tween  ditunjukkan dengan
frame berwarna ungu dan garis pa-
nah yang menunjuk dari titik hitam
ke titik hitam lainnya . Sekarang klik
menu Control  → Test Movie  untuk
menjalankan animasi. 

Tambahkan efek tint
Hentikan animasi yang telah dija-
lankan, sekarang tambahkan sedikit
efek.  Klik Frame 1, lalu klik Win-
dow→ Panels→ Effect, Pilih Tint
pada drop-down menu dan Tint
Color: Biru. Lakukan hal yang sama
pada Frame 15 dengan Tint Color:
Merah dan Frame 30: Ungu

Atur Movie
Pengaturan movie dapat
dilakukan melalui Movie
Properties. Klik menu Modify →
Movie , isikan Width: 200 px,
Height: 100 px dan Background
Color: Hitam

Mengatur dan menulis teks
Aturlah huruf yang akan dituliskan,
klik menu Text  → Characte,  lalu
pilih Arial Black  pada bagian Font
dan ukurannya, 14. Kemudian
pada bagian Colors  yang terletak
di bagian kiri layar Flash, klik Text
Tool ,  dan tulislah kata NeoTek di
Movie. 

1

7 8

2

Penggunaan tweening pada Flash

Tambahkan suara
Agar tampak lebih cool, tambahkan
suara. Klik Frame 1, lalu klik menu
Window → Common Libraries →
Sounds, maka daftar Libray Sounds
yang telah disediakan Flash akan
tampil, pilih salah satu, misalnya:
Beam Scan. Drag ke atas tulisan
NeoTek yang berada di Movie.

9
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menggerakkan satu objek dari lokasi
ke lokasi lainnya sambil mengisi
bagian-bagian di antara frame-nya
sehingga transisinya menjadi mulus.
Proses ini disebut motion tween.

Motion tween adalah contoh tween
(pengantara) yang paling umum dan
sederhana. Dengan efek ini, Flash da-
pat memperantarai posisi, rotasi, ukur-
an, dan bahkan warna. Dengan fungsi
ini, warna dapat berubah secara berta-
hap atau objek muncul dan menghi-
lang dengan menggunakan alpha atau
tint color.

Untuk memulai proses gerak tween,
pertama kita perlu menentukan suatu

objek dan menjadikannya sebagai
symbol.  Jika tidak menjadi simbol,
objek itu tidak akan bekerja dengan
benar dan hanya akan menyebabkan
anda frustrasi. Jadi, jika anda membuat
suatu objek, atau mengimpor suatu
image, pastikan anda mengubahnya
menjadi simbol (cara termudah adalah
dengan menggunakan F8 pada key-
board.) Simbol itu kemudian akan ter-
lihat di library dan dapat digunakan
berulang-ulang.

Untuk dapat menggerakkan sebuah
simbol anda memerlukan sebuah titik
awal dan titik akhir yang akan menjadi
lintasan geraknya. Tempatkan simbol

yang akan anda gunakan pada stage
dan pastikan ada satu keyframe yang
akan menjadi awal tween untuk layer
tempat anda menempatkan simbol itu.
Setelah selesai, kini buat keyframe lain
di posisi lain pada layer tersebut yang
akan menjadi titik akhir gerakan. Jika
setelah view, anda merasa gerakan
terlalu cepat atau lambat, anda dapat
menyesuaikan lokasi titik awal/akhir
dengan klikan dan geretan mouse. Jika
akhir keyframe telah ditentukan, anda
dapat mengklik simbol tersebut dan
memindahkannya ke lokasi lain yang
akan menjadi ujung dari gerakan
tween. Selanjutnya silakan ikuti
tutorial di bawah ini.

Publikasikan ke browser
Sebelum dipublikasikan simpan-
lah terlebih dahulu animasi yang
telah dibuat, klik File  → Save
As.  Untuk menampilkan di
browser, klik File  → Publish
Preview  → HTML. Maka seka-
rang anda sudah mempunyai file

Mengatur time line
Timeline terletak di atas Movie,
terdiri dari frame-frame. Sekarang
klik Frame 15  lalu klik menu
Insert  → Keyframe  untuk mem-
berikan Keyframe pada Frame 15.
Lakukan hal yang sama pada
Frame 30. 

Memperbesar tulisan
Klik Frame 15,  lalu klik menu
Modify  → Transform → Scale and
Rotate, isikan Scale: 150 %,  lalu
klik OK.

4

10

5 Animasi tulisan
Inilah saatnya untuk memberikan
animasi. Klik Frame 1  lalu pilih me-
nu Modify  → Frame. Pilihlah Mo-
tion  pada bagian Tweening. Lakukan
hal yang sama pada Frame 15. 

6

HINT & TIPS • HINT & TIPS • HINT & TIPS • HINT & TIPS • HINT & TIPS • HINT &

Ketika mempertimbangkan untuk
menggunakan animasi tweening di
Flash, desainer biasanya hanya ber-
pikir mengenai motion tweening.
Padahal kekuatan Flash lebih dari
sekedar animasi motion tweening itu.
Anda pun sebenarnya dapat meng-
gunakan tweening untuk menganima-
sikan bentuk, rotasi, warna, dan
opasitas suatu objek.

Hal yang perlu diingat mengenai
tweening adalah bahwa tweening
hanya dapat diterapkan pada objek.

Macromedia mendefinisikan objek
sebagai simbol, groups, text boxes,
dan grafik imporan.

Coba gunakan simbol dalam animasi
anda. Ukuran file simbol biasanya
lebih kecil dibandingkan object group
dan raster image.  Seperti telah
disinggung di atas, semua tweening
minimum harus mempunyai dua
keyframe, awal dan akhir. Jika anda
berencana untuk men-tweening-kan
beberapa objek, masing-masing objek
harus diberi layer tersendiri. 

Tweening Bukan Hanya Motion
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emang ASP bisa saja ditulis
dengan mengguna-kan teks
editor sederhana seperti mi-

salnya Notepad, atau bisa juga de-
ngan MS Frontpage dan MS Words.

Tetapi jika semua itu dibandingkan
dengan ASPEdit tampak akan jauh
lebih mudah jika kita menggunakan
alat bantu ini. Ya, karena ASPEdit
memang dibuat khusus untuk me-
nulis file-file ASP.

ASPEdit buatan Tashcom Software
ini merupakan shareware, sehingga
kita bisa memanfaat-kannya secara
gratis meski dalam waktu terbatas.

CCARARA MA MUUDDAH BAH BEELLAAJJAR AR 
AASSP DP DEENNGGAN AN 
AASSP EP EDDIIT 200T 20011

M

1
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BUKA DENGAN WINZIP
Klick dua kali file aspedit.zip yang baru di-
download, maka secara otomatis jendela
Winzip akan terbuka. Klik ikon Install
untuk menginstal ASPEdit ini ke PC kita.
Perhatikan tanda Minimize during Install
dengan tanda cek, biasanya sih secara
default sudah dicek. Setelah itu klik OK.

SETUP ASPEDIT
Setup pun mulai dijalankan, kita disambut
kotak dialog Welcome to ASPEdit 2001.
Nah, kotak dialog ini akan mulai memandu
secara step by step sampai instalasi selesai.
Jadi kita tinggal mengikuti saja. Setup ini
juga mengingatkan pada kita untuk mem-
buat backup copies untuk data-data kita
yang penting. Klik tombol Next.

DIREKTORI INSTALASI
Kotak dialog Choose Destination Location,
menawarkan apakah akan mengganti letak
direktori ASPEdit yang akan diinstal. Kalau
tidak, yang akan dipakai adalah direktori
defaultnya yaitu C:\Program Files\Tashcom
Software\ ASPEdit 2001. Klik Next  untuk
menerima folder default.

FORMAT PESAN EMAIL ANDA
Nah, akhirnya kotak dialog Start
Copying Files  yang muncul. Ini artinya
Setup sudah siap untuk mulai mengko-
pikan file-file alias menginstal ASPEdit
2001 ke PC kita. Langsung saja klik
Next  untuk mulai. 

FOLDER INSTALASI
Kotak dialog Select Program Folder
memberitahu bahwa akan dibuatkan ikon
dalam Program Folder, yang nantinya bisa
kita gunakan untuk memulai ASPEdit ini
dari tombol Start → Programs. Biarkan
saja pada default-nya yaitu ASPEdit 2001.
Klik tombol Next  saja lagi.

Men-download dan menginstal ASP Edit

Jika ingin lebih mudah menulis script atau file ASP (Active Server
Pages), ada baiknya mengenal ASPEdit 2001 yang merupakan
alat bantu yang paling cocok untuk menulis file ASP. Roswati S.
menyajikannya untuk anda.

DOWNLOAD ASPEDIT
Download dahulu  ASPEdit 2001 ini dari
http://www.aspedit2001.com/download.
asp. File yang kita download ini berfor-
mat .zip file dan besarnya sekitar 6 MB.
Bila tidak mau repot cari saja di CD
NeoTek bulan ini.
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TUTUP APLIKASI LAIN
Yang muncul masih kotak dialog Welcome
to ASPEdit 2001 Setup!  Tapi sekarang me-
nyarankan untuk mematikan semua ap-
likasi yang lain. Jika anda masih sedang
menjalankan aplikasi yang lain, klik Can-
cel,  untuk membatalkan Setup. Tutup
semua aplikasi lain, baru jalankan lagi
langkah-langkah ini.

LICENSE AGREEMENT
Sekarang muncul kotak dialog Software
Lisence Agreement..  Klik tombol Yes
untuk melanjutkan ke langkah selanjut-
nya. Tapi kalau anda ingin membacanya,
dan ternyata tidak jadi menginstal, klik
tombol No.  Anda akan keluar dari Setup.

README INFORMATION
Jika anda melanjutkan, akan tampil kotak
dialog Readme Information.  Isinya tentang
informasi yang mungkin sewaktu-waktu
anda perlukan, misalnya masalah bug
report, update atau ada juga lisensi khusus
untuk keperluan pendidikan, yang bisa
anda cek langsung di situs Tashcom
Software. Klik tombol Next.

MENENTUKAN RETURN RECEIPTS
Maka proses penginstalan itu pun dimulai.
Sekarang kita tunggu saja beberapa saat
sampai proses selesai.

INSTALASI SELESAI
Jika kotak dialog Setup Complete,  muncul
artinya proses instalasi sudah selesai. Di
PC kita sekarang sudah ada ASPEdit yang
siap digunakan. Jika anda ingin agar ASP-
Edit ini dijalankan sekarang juga, tandai
Yes, Launch the Program File.  Lalu klik
Finish  untuk keluar dari Setup. Kalau
tidak, ya tidak usah ditandai.

MENJALANKAN ASP EDIT
Maka program ASPEdit pun akan mulai
dijalankan. Pada kotak dialog pembuka
yang muncul, klik I’m still evaluating
untuk masuk ke program.

Beberapa fitur ASPEdit 2001

• Wizard for All Difficult Task. Ham-
pir semua aplikasi ASP yang agak
sulit dibuatkan wizardnya oleh
ASPEdit, misalnya saja aplikasi un-
tuk mengirim email, aplikasi data-
base, dan masih banyak lagi.

• Validators. Sangat berguna untuk
mencek apakah skrip (script) yang
anda tuliskan sudah benar atau ma-
sih mengandung kesalahan.

• Source Tidier, Code Explorer, yang
paling memudahkan kita. Dengan
Code Explorer ini kita tinggal klik
dua kali, tidak usah menulis skrip
lagi. Cukup klik sini klik sana sudah
jadi skripnya. Cepat, mudah, dan
dijamin lebih akurat, dan akan sangat

jarang terjadi kesalahan pada penu-
lisan skrip.

• Publishing Wizard. Tidak kalah dengan
MS FrontPage. ASPEdit juga sudah
dilengkapi dengan step by step yang
menuntun sampai publikasi selesai.

• Comprehensive Tutorial. Siapa yang
belum tahu ASP? Tutorialnya diser-
takan pada ASPEdit. Ada 12 pelajaran
sederhana, cocok buat pemula.

• Guidance Assistant. Untuk yang
suka ditemani oleh assisten yang
lucu, ASPEdit menyediakan guide
lucu yang dapat membantu Anda.

• SQL Query Builder. Ini untuk
membuat query SQL, misalnya saja
mengambil atau memasukkan data,
atau mungkin meng-update data.

• SQL Table Builder. Kalau ini untuk
membuat dan menghapus tabel, dan
sebagainya.

• Masih banyak sih yang lainnya, mi-
salnya saja adanya penomoran baris-
baris skrip, yang tentu saja akan sa-
ngat memudahkan kita dalam men-
cari letak baris jika terja-di kesalahan,
fasilitas autocomplete pada saat penu-
lisan objek-objek built in ASP,pewar-
naan background  script ASP yang
menjadikan kita tahu dengan pasti
apakah kita sedang menulis di
antara delimiters atau tidak.
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angsung saja buka ASPEdit,
dari Start → Program →
ASPEdit → ASPEdit 2001.

Tunggu beberapa saat ketika software
loading.  Kemudian muncul kotak
dialog Shareware Notice.  yang
mengingatkan bahwa Anda menggu-
nakan software trial. Anda diingatkan
bahwa masa trial software ini adalah
50 kali pakai. Sekarang klik saja
tombol I m still evaluating  untuk
masuk ke aplikasi ini.

Setelah itu terbukalah jendela
ASPEdit 2001. Di pojok kanan
bawah terdapat asisten yang lucu,
yang posisinya bisa dipindah-
pindah dengan cara men-drag sang

L

SAVE DI C:\INETPUB\WWWROOT\
Selanjutnya yang akan muncul adalah
kotak dialog Save Page.  Simpanlah
file baru ini pada folder
C:/Inetpub/wwwroot/ dengan
nama pertama.asp.

4
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LEMBAR KERJA PERTAMA.ASP
Pada lembar kerja pertama.asp, sudah
dibuatkan tag-tag HTML lengkap dengan
META tag. Memang hanya sampai
</HEAD>. Tinggal menambahkan tag
body dan tag penutup HTML. Jika itu
pun malas, biarkan ASPEdit menulis-
kannya. Gunakan tag body Wizard
untuk menuliskan tag body document.

TAG BODY WIZARD
Pertama letakkan pointer mouse pada
tepat satu baris dibawah tag </HEAD>.
Pilih Insert > HTML-Statement > Body
Wizard. Muncul kotak dialog Document
Properties,  Di sini masukkan opsi-opsi
untuk body tag sesuai keinginan, mi-
salnya Background Picture  untuk mem-
beri latar belakang pada halaman web.

TAG PEMBUKA & PENUTUP ASP
Sekarang tuliskan delimiters untuk
ASP, yaitu tag <% sebagai pembuka
dan tag %> sebagai penutupnya. Di
antara kedua tag iniliah skrip-skrip
ASP akan dituliskan. Kalau Anda
menulis di luar delimiters ini, maka
server tidak akan mendapatkan dan
akan mengeksekusinya.

MEMASANGKAN DELIMITERS
Untuk memasukkan delimiters, perta-
ma tempatkan dahulu pointer di
bawah tag <body>. Lalu dari File and
Tag Manager, klik dua kali <%:%>,
kemudian tekan Enter sekali untuk mem-
buat baris baru.

WARNA KUNING PADA DELIMITER
Pastikan semua skrip ASP dituliskan
di antara delimiters ini. Untuk memas-
tikan hal ini ASPEdit secara otomatis
akan memberi warna kuning sebagai
latar area penulisan ASP skrip. Jika
saat menulis skrip ASP latarnya tidak
kuning, maka berarti sedang menulis
di luar delimiters.

Menggunakan ASPEdit untuk menulis file ASP

FILE ASP YANGFILE ASP YANG
PERTAMA DENGANPERTAMA DENGAN
ASP EDITASP EDIT
Setelah pada bagian sebelumnya kita menginstal ASPEdit 2001,
sekarang mari mempelajari cara menggunakan ASPEdit 2001 untuk
menulis file ASP sederhana yang akan kita coba jalankan di PWS. 

tempatkan
delimiters
<% dan
%> di sini
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MENENTUKAN BACKGROUND
Klik ikon folder di sebelah kanan boks
untuk mencari atau menentukan letak
file image yang akan digunakan se-
bagai background. Tandai watermark
jika anda ingin menggunakan efek
watermark. Bisa juga pilih warna-warna
untuk dijadikan warna dasar halaman
jika tidak menggunakan gambar.

PENGATURAN WARNA & MARGIN
Background color: menentukan warna
latar, Hyperlink color: menentukan war-
na link yang belum diklik, Active Link
color: menentukan warna link halaman
yang sedang aktif, Text color: menentu-
kan warna teks default pada seluruh ha-
laman, Visited Link Color: menentukan
warna link yang telah dikunjungi. Di
kanannya pengaturan margin. Klik OK.

PERSIAPAN MEMBUAT SKRIP ASP
Enter dua kali, agar antara tag <body>
dengan tag </body> terdapat dua baris
kosong. Di bawah tag </body> tag pe-
nutup </html>. Kini kita siap membuat
skrip ASP di antara body tag tersebut.
Tampilkan dulu semua tag ASP dengan
memilih menu Tags/Commands →
Show ASP Commands. Muncullah list
dari semua tag ASP yang akan

RESPONSE.WRITE
Method artinya cara atau langkah yang
harus dilakukan oleh Object itu, yaitu
menulis dokumen (maka dinamakan
Write). Nah di sini terlihat bahwa ASP
sangat mudah dipahami hanya dengan
mengerti bahasa Inggris. Response.Write
artinya respons yang diberikan oleh
server berupa penulisan pada dokumen.

CARA OTOMATIS RESPONSE.WRITE
Caranya? Letakkan pointer di antara
delimiters. Dari menu bar Insert →ASP
→ASP-General ASP → Response State-
ment → Response.Write . Tidak perlu
mengetikkan secara manual, dan salah
ketik bisa dihindari. Ganti teks di antara
tanda kutip, dalam hal ini <your text
here>  dengan Selamat Belajar ASP!

FILE ASP ANDA YANG PERTAMA
Sekarang tinggal save. Klik ikon Save
yang terdapat pada toolbar. Selesai
sudah file ASP sederhana kita. Mari
kita coba jalankan. Buka Internet
Explorer. Lalu masukkan alamat
http://localhost/pertama.asp.
Mudah kan ASP? Jangan lupa PWS-
nya harus dalam keadaan aktif!

1 2 3
GENERATE NEW PAGE
Pada box <Page Title>, ketikkan
nama file baru yang akan kita buat,
misalnya Belajar ASP  (tuliskan
tanpa tanda kutip). Setelah itu klik
tombol Generate New Page  pada
sebelah kanan bawah kotak dialog.

NEW FILE
Klik File → New. Akan muncul kotak
dialog New Page.  Di sini kita diminta
memasukkan identitas file baru yang
akan kita buat. File Type  mempunyai
tiga pilihan ASP, HTM, dan
WML/WAP. Secara default, yang
terpilih Active Server Pages.

TIPE FILE DAN OPSI
<ASP Option> untuk menyertakan opsi
ASP umum ke dalam file baru yang akan
kita buat. Ada tiga pilihan opsi, bisa pilih
satu atau lebih, yaitu Include VBScript
opening tag.  Tag ini nantinya akan
memberitahu server bahwa bahwa
yang akan digunakan adalah VBScript.
Sementara ini tidak diperlukan.

Opsi lain Script Timeout (60 seconds) untuk menen-
tukan batas waktu script dieksekusi, serta opsi
Session State Enable yang merupakan pendekla-
rasian apakah session diizinkan digunakan atau
tidak. Secara default ketiga opsi ini tidak akan
dipilih, dan memang tidak perlu kalau yang akan
kita buat adalah file yang sederhana saja.

Pada ASP digunakan Response.Write untuk me-
nulis pada dokumen. Response adalah salah satu
dari beberapa jenis object build dalam ASP. Object
Response sangat penting, karena fungsinya ber-
kaitan dengan pengiriman data ke client (memberi
respon). Write adalah salah satu Method dari
Object Response ini.
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DynamicDynamic HHTTMML:L:

BERBEDA DENGAN APPLET, FLASH
dan lainnya, source code un-
tuk script langsung diketik di

antara HTML, jadi script bersifat open
source. Ada dua script yang umum
untuk web: JavaScript dan VbScript.
JavaScript lebih populer karena VbScript
tidak didukung oleh Netscape.

Apa saja yang dapat dilakukan
olehJavaScript? 
• JavaScript dapat menambahkan teks

secara dinamis 
• JavaScript dapat bereaksi terhadap

event, misalnya onLoad
• JavaScript dapat membaca dan

mengganti attribut untuk tag HTML
• JavaScript dapat melakukan validasi

pada data

Untuk memasukkan JavaScript dalam
HTML, kita harus menggunakan tag
<script> dengan attribut "type" dan
value "text/javascript." Setelah menu-
lis scriptnya, tutup dengan </script>

<html>
<head>
</head>
<body>
<script type="text/javascript">
document.write("Contoh Program JavaScript")
</script>
</body>
</html>

Cara kerja script diatas adalah meme-
rintahkan objek yang bernama document,
yakni file HTML tempat script tersebut
berada, untuk menuliskan kata "Contoh
Program JavaScript." Dengan demikian,
tulisan tersebut akan muncul pada do-
kumen jika ditampilkan di browser.

Penting diingat bahwa tidak semua
browser mendukung JavaScript. Browser-
browser lama ataupun browser baru
yang dukungan terhadap scriptnya di-
matikan tidak dapat memproses script
ini dan kemungkinan akan menim-
bulkan masalah pada hasil tampilan.

Untuk mengatasi masalah itu, kita
menggunakan tag comment "<!--  //--
> untuk "menyembunyikan" script

kita dari browser yang tidak mendu-
kungnya , sehingga penulisannya
menjadi:

<html>
<head>
</head>
<body>
<script type="text/javascript">
<!--
document.write("Contoh Program JavaScript")
//-->
</script>
</body>
</html>

Untuk selanjutnya, kita akan mencoba
membuat sebuah script yang akan me-
nampilkan jam yang terus berjalan. Script
mungkin tampak rumit tapi sebenarnya
cukup sederhana jika dipahami.

<html>
<head>
<script type="text/javascript">
var timer = null
function stop()
{
clearTimeout(timer)
}
function start()
{var time = new Date()
var hours = time.getHours()
var minutes = time.getMinutes()
var seconds = time.getSeconds()
var clock = hours
clock += ((minutes < 10) ? ":0" : ":") + minutes
clock += ((seconds < 10) ? ":0" : ":") + seconds
document.forms[0].display.value = clock;
timer = setTimeout("start()",1000)
;
}</script>
</head>
<body onload="start()" onunload="stop()">
<form>
<input type="text" name="display">
</form>
</body>
</html>

Pertama-tama var timer = null meng-
hasilkan variabel timer yang nilainya
tidak ada (null)

Kemudian buat fungsi yang dinamakan
stop() dengan tugas clearTimeout

Fungsi ini gunanya untuk menghenti-
kan eksekusi script.

Kemudian kita buat fungsi yang dina-
makan start() dan deklarasikan variabel-
variabel berikut:

• time mengambil tanggal hari ini
• hours mengambil jam dari time

(berarti jam saat ini)
• minutes mengambil menit dari time
• seconds mengambil detik dari time
• clock dideklarasikan sebagai

penampung data jam

Kemudian clock ditampilkan pada sebuah
elemen yang bernama "display" setiap
ada perubahan waktu 1000 milidetik (1
detik). Terakhir buat input textbox
dengan nama "display" untuk menam-
pilkan waktu.

Hasil akhirnya adalah sebagai berikut:

Tentu saja kita bisa menambahkan ka-
limat sebelum input textbox misalnya :

Saat ini pukul:

Jam yang ditampilkan adalah jam lokal,
jadi jam berdasarkan komputer pengun-
jung situs, bukan jam server. Dengan
menggunakan teknik yang mirip de-
ngan script diatas, dapat juga ditampil-
kan hari, tanggal, bulan serta tahun
yang sesuai dengan komputer pengunjung.

Tehnik Javascript diatas baik dipelajari
untuk pemula. Masih banyak lagi fungsi-
fungsi Javascript yang lebih kompleks
yang dapat membuat tampilan web
menjadi lebih dinamis.

PPenggunaan JavaScript dalam DHTMenggunaan JavaScript dalam DHTMLL
Script adalah istilah yang diberikan untuk bahasa pemrograman yang bersifat

sederhana. Dalam membuat halaman web yang dinamis, script adalah
komponen yang sangat penting. Tanpa adanya script, nyaris tidak mungkin untuk

membuat halaman web yang benar-benar interaktif. 

S
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Diasuh oleh: Irwan Effendi, CWP
Instruktur Senior Web-C, Jakarta

http://www.webmastercertification.web.id
irwan@webmastercertification.web.id



NeoTutor

Januari 2002 NeoTek 21

EBELUM ANDA MEM-
baca artikel ini, kami
buat disclaimer dulu

yaitu “bahwa artikel ini ha-
nya untuk tujuan informasi
dan pendidikan saja dan jika
anda memanfaatkannya un-
tuk tujuan lain, maka hal
itu diluar tanggung jawab
redaksi.” Pernyataan ini ha-
nya sekedar mengikuti etika
yang dilakukan oleh para
cracker sebelum mereka me-
nulis essay tentang software
cracking.

Jika anda sering men-down-
load program di Internet,
tentu sering menemui istilah
shareware atau demo version.
Pasti anda juga sudah tahu
cara mendapatkan obatnya
agar program tersebut men-
jadi full version, yaitu  dengan
sering-sering mengunjungi
situs-situs underground
yang salah satunya adalah
www.astalavista.com.

Tetapi pada akhirnya anda
pasti juga ingin tahu bagai-
mana cara meng-crack se-
buah software dari demo
menjadi full version atau se-
tidaknya, anda bisa menjalan-
kan software tersebut tanpa
harus registrasi untuk men-
dapatkan password-nya.

AAppaakkaahh  CCrraacckkiinngg  IIttuu??
Cracking adalah membuat
suatu program yang dapat
berfungsi secara utuh (fully
functional) dari suatu share-
ware atau versi demo yang
mempunyai limit pemakai-
an tertentu seperti 30-day
trial, 30-uses trial, dll. Caran-
ya dengan mengubah source
code atau mencari serial
number/key file/registry
entry. Cracking adalah pro-
ses registrasi secara ilegal
pada sebuah program.

Perlu diketahui bahwa
cracking tidak sama dengan
hacking! Artikel ini tidak
membahas cara meng-hack
suatu situs, server, irc-client,
dan lain-lain, tetapi cracking
bisa juga menjadi bagian
dari  hacking.

RReevveerrssee  EEnnggiinneeeerriinngg??
Reversing atau reverse engin-
eering jauh lebih kompleks
dibandingkan cracking. Re-
verse engineering tidak sela-
lu melakukan cracking suatu
program tetapi lebih kepada
debugging atau disassem-
bling suatu program untuk
mempelajari sesuatu seperti
mempelajari virus baru atau
cara kerja skema proteksi.

Reversing adalah tahap ber-
ikutnya setelah anda mahir
melakukan cracking.

IInnggiinn  JJaaddii  CCrraacckkeerr??
Ada tiga persyaratan mini-
mal yang harus dipenuhi
untuk menjadi seorang
cracker. Pertama, anda ha-
rus mempunyai pengalam-
an berkomputer yang luma-
yan sehingga anda sudah
tahu apa itu DOS, Windows,
file .ZIP/.ARJ dan sebagai-
nya. Kedua, anda sudah me-
ngerti apa itu Assembler,
perintah-perintah dasarnya
seperti call, mov, cmp, or
atau xor.

Semua bahasa tingkat tinggi
yang dipakai seperti C,
C++, Pascal, Java, akan di-
compile ke dalam bahasa
assembly sehingga dapat
dimengerti oleh komputer.
Karena itu jika anda semakin
dalam pengetahuan anda
tentang assembly, akan se-
makin baik.

Yang ketiga, adalah kesabar-
an dan “feeling!” Kesabaran
akan membutuhkan waktu
dan waktu adalah aset terbe-
sar seorang cracker. Sedang-
kan feeling akan datang de-
ngan sendirinya jika anda

sering mengutak-atik kode
assembly. Jika  anda dapat
merasakan suatu skenario
program, maka anda telah
menguasai seni reverse
engineering ini.

Proses menjadi seorang
cracker yang handal mem-
butuhkan waktu bertahun-
tahun. Anda harus sering
membaca essay tentang
“How to crack” seperti yang
sekarang anda baca ini atau
sering-seringlah berselancar
di lautan informasi, Inter-
net! Selain itu anda juga
harus sering berlatih dan
harus terus terobsesi de-
ngan ‘binatang’ cracking
ini.

Yang terakhir, anda harus
menyadarkan diri sendiri
bahwa anda ttiiddaakk  ppeerrnnaahh
ttaahhuu  sseeggaallaannyyaa. Are you
ready to become cracker?

AAppaakkaahh  AAsssseemmbblleerr  IIttuu??
Assembler adalah suatu
program yang mengkon-
versi suatu source code ke
bahasa assembly/mesin
menjadi file yang dapat
dieksekusi: .exe atau.com.
Jika anda hanya menulis-
kan satu baris perintah
dalam bahasa C++, maka

SoftSoftware ware CrCrackingacking
Memacu Minat Belajar AMemacu Minat Belajar Assembly Languagessembly Language

Cracking adalah seni mengubah suatu program agar bersedia melakukan apa
yang kita inginkan dan bukannya apa yang diinginkan oleh programer software itu.

Cracking dapat menjadi cara untuk memacu gairah belajar pemrograman.

S
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untuk perintah yang sama
anda harus menuliskan be-
berapa instruksi. Untuk le-
bih jelasnya, lihat contoh
berikut:

SSttaarrtt  ppaarrttiiaall  ccooddee  ((cc++++))

#include <iostream.h>

void main(void) {

cout << "Hello world!\n" ;

}

EEnndd  ppaarrttiiaall  ccooddee

SSttaarrtt  ppaarrttiiaall  ccooddee  ((aasssseemmbblleerr))

code   segment

assume cs:code, ds:code

org 100h

begin: jmp short main

main   proc near

mov ah, 09h

mov dx, offset msg

int 21h

exit:    mov ax, 4C00h    

int 21h

maind endp

code     ends  

end    begin

msg db 13,10,"Hello
world!",13,10,"$"

EEnndd  ppaarrttiiaall  ccooddee

Menakutkan? Tetapi, sekali
anda mengerti cara kerjanya,
sesungguhnya assembler
itu tidak terlalu sulit. Satu-
satunya cara mengatasinya
adalah dengan belajar assem-
bler. Kenapa? Karena pada
saat anda meng-crack, yang
anda lihat hanyalah instruk-
si-instruksi assembler ini.

Saat anda melakukan dis-
assemble suatu program
yang ditulis dalam bahasa
C, anda tidak akan melihat
source code C tetapi kode
assembler. Kenapa? Karena
setiap program (ditulis da-
lam bahasa C, Java, Visual
C, dll) akan dikompilasikan
ke dalam kode mesin. Se-
buah program disassembler
seperti W32Dasm tidak da-
pat mengetahui bahasa asli
yang dipakai untuk menu-
liskannya. Program ini ha-
nya melakukan tranlasi dari
kode mesin menjadi instruk-
si assembler. Karena itulah
anda harus mengerti instruksi-
instruksi assembler sebe-
lum mencoba untuk mela-
kukan cracking. Download
tutorialnya di-download di
http://users.belgacom.net/bla

ckb/asmtut.zip

IIssttiillaahh  DDaassaarr  AAsssseemmbbeerr
AA..  RReeggiisstteerrss

Registers adalah variabel-
variabel yang ditempatkan
dalam prosesor komputer
anda. Prosesor mengguna-
kan variable ini untuk ope-
rasi dasar matematika dan
logika. Register yang sering
digunakan adalah : eax, ebx,
ecx dan edx. Kadang anda
juga akan menemukan edi,
esi, esp, dan ebp.

Ada tiga jenis register yaitu
register 32bit, 16bit dan 8bit.
Register 32bit dimulai de-
ngan e seperti eax. Register
16bit register adalah ax, bx,
cx, dx, di, si, sp, bp. Sedang-
kan register 8bit register
adalah al, ah, bl, bh, cl, ch,
dl, dh. l- berarti 8 bit yang
terkecil dari register 16bit
register dan h- berarti 8 bit
terbesar dari register 16bit.

BB..  FFllaaggss

Flags adalah variable Boolean
yang bernilai 0 atau 1. Flags
digunakan oleh prosesor un-
tuk melakukan operasi mate-
matika dan logika secara in-
ternal. Flag yang paling pen-
ting adalah Zero Flag, yang
nilainya dapat 0 atau 1.

CC..  CCooddee  FFllooww

Pada saat anda sedang meng-
analisa potongan kode, harus
diingat bahwa prosesor itu
sangat bodoh dan yang dila-
kukannya hanyalah meng-
ikuti instruksi dasar, baris
demi baris dari kode yang
dituliskan dan tidak akan
mengikuti kode yang tidak
dituliskan. Karena itulah
anda harus berfikir seperti
prosesor jika sedang meng-
analisa suatu potongan kode
mesin dan juga bertingkah
laku seperti prosesor yaitu:
tarik nafas, hembus nafas,
tarik, hembus, taik… stupid
joke!

Pada prinsipnya anda harus
melakukan apa yang prose-
sor lakukan seperti compare
register, variable, execute
jump dan call, menghitung
operasi matematika, simpan
dan lain-lain. Untuk mela-
kukan ini, prosesor memi-
liki Instruction Pointer yang

dengan ini prosesor meng-
arahkan instruksi-instruksi
yang harus di-eksekusi.

MMeettooddee  PPrrootteekkssii
Dari sekian banyak
shareware program, kita
dapat mengidentifikasi
metode-metode yang sering
dipakai untuk memproteksi
shareware tersebut seperti
berikut.

Nag Screen: Bentuk proteksi
yang paling sederhana ada-
lah munculnya sebuah jen-
dela kecil sebelum program
load up yang isinya meng-
ingatkan anda untuk mem-
beli software itu. Biasanya
window ini dibuat dengan

Paint Shop Pro dan Textpad

Expiration: Program ini akan
habis masa bekerjanya sete-
lah waktu tertentu atau sete-
lah dipakai sebanyak sekian
kali. Untuk melakukan ini,
beberapa metode digunakan
antara lain pengecekan tang-
gal dan registry flag check.

User Registration: Program
ini meminta anda untuk me-
masukkan kode registrasi/
serial number yang  didapat
setelah anda melakukan regis-
trasi ke alamat situs dari
software yang anda jalankan.
Contohnya adalah WinZip
dan CuteFTP.

Commercial Strength Wrappers:
Banyak pengembang soft-
ware melepas produknya de-
ngan konsep coba sebelum
membeli yang ditangani oleh
sebuah wrapper yang me-
mungkinkan pelanggan me-
lakukan registrasi secara
online setelah memasukan
informasi seperti nama, email,
credit card dan telepon. Bebe-
rapa commercial wrapper ada-
lah Release Software Agent,
VBox, unBoxed, Techwave
dan Stirling. Wrapper ini

menggunakan routine yang
sangat kompleks tetapi se-
kali saja sebuah wrapper
berhasil di-crack, maka se-
mua software yang meng-
gunakan wrapper tersebut
dapat di-crack secara oto-
matis. Ya, jika anda berhasil
meng-crack DLL yang digu-
nakan suatu wrapper, maka
jika anda meng-install setiap
program yang menggunaka
wrapper tersebut, maka pro-
gram tersebut akan otomatis
berubah menjadi versi yang
sudah cracked. Semua pro-
duk Symantec seperti Nor-
ton Utilities, AntiVirus me-
makai metode ini.

Dongle (Hardware) Protection:
Sebuah  hardware lock dise-
diakan bersama program
yang berisi kunci unik atau
beberapa fungsi API. Program
ini akan mengecek keberada-
an lock ini pada saat starting.
Contohnya adalah AutoCAD
dan Tally.

SSkkeemmaa  CCaarraa  CCrraacckkiinngg
Pada prinsipnya ada dua
skema pendekatan untuk
melakukan cracking yaitu
dengan pendekatan: DDeeaadd
LLiissttiinngg (dengan W32Dasm)
dan SSeerriiaall  FFiisshhiinngg (dengan
SoftICE)

Dead listing adalah disas-
sembling, digunakan untuk
metode proteksi seperti Nag
Screen dan Expiration.

Sedangkan Serial fishing
adalah pencarian serial code
digunakan untuk metode
proteksi User Registration.

Ada banyak cara untuk me-
lakukan cracking dan yang
dibahas disini adalah yang
paling dasar untuk anda
ketahui.

TTooooll  YYaanngg  DDiippeerrlluukkaann
Bila anda melakukan cracking
dengan pendekatan dead
listing, maka anda mencoba
mendapatkan kode assem-
bly dari source code soft-
ware itu. Untuk itu kita
harus melakukan disassem-
bly, yaitu proses pengubah-
an source code dari suatu
file program ke bentuk
kode assembly/mesin. Tool
untuk pekerjaan ini adalah
suatu utilitas yang sering
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dipakai oleh para cracker,
yaitu WWiinn3322  DDiissaasssseemmbblleerr
atau yang lebih dikenal
sebagai WW3322DDaassmm.

Win32 Disassembler dapat
melakukan pekerjaan seba-
gai berikut:

1. Disassemble files: men-
translate program ke ben-
tuk kode assembly atau
kode mesin. Tipe-tipe file
yang dapat dikerjakan
adalah exe, 386, com, cpl,
drv, dll, fon, mpd, ocx,
vbx, dan vxd.

2. Load proses program
dan trace program

3. Browse file yang telah
di-disamble

4. Find teks

5. Execute, insert atau
remove jumps dan calls

6. Fungsi import dan
export

7. Show tampilan HEX
dari suatu area kode mesin

8. Show daftar STRING,
DIALOGS dan REFERENCES

9. Save disassembly source
dalam format teks.

Tool selanjutnya yang ha-
rus dipunyai adalah HHiieeww,
yang sering disebut seba-
gai HHaacckkeerr''ss  VViieeww. Tool
ini mampu melakukan:

1. Disassemble files

2. Membuat perubahan
pada file yang telah di-
disassemble seperti perin-

tah Write, Modify dan
Reassemble file

3. Melihat file dalam ben-
tuk ASCII, HEX atau
Assembly

Download tool-tool ini di
wwwwww..aassttaallaavviissttaa..ccoomm
bersama dengan crack-nya.

Kedua tool diatas dapat
dipakai untuk cracking
dengan pendekatan dead
listing sedangkan untuk
pendekatan serial fishing,
digunakan SoftICE.

LLaannggkkaahh--llaannggkkaahh  CCrraacckkiinngg
1. Jalankah program yang
ingin di-crack dan pelajari
tabiat standar-nya. Coba
masukkan password dan
lihat responnya.

2. Buka program itu de-
ngan W32Dasm dan laku-
kan disassemble terhadap
program itu.

3. Carilah kata-kata kunci
dari file yang telah di-dis-
assemble itu seperti pass-
word, name, date, expired,
time limit, wrong, entered
dan yang sejenisnya.

4. Temukan dan observasi
password generator, cari
learn protection routine
dan API Calls

5. Cobalah untuk mema-
hami mekanisme jump
dari skema protection

6. Sekarang buka program
yang ingin di-crack dengan
Hiew. Ubah jump dari

suatu flow control ke arah
berlawanan dari jump
command  atau gunakan
NOP (No Operation)

7. Jalankan program itu
dan lihat pengaruh per-
ubahan kode yang telah
dilakukan dalam Hiew.
Resapi kekuatan yang anda
punyai, the power of
cracking, membuat suatu
program bertindak sesuai
dengan yang anda inginkan.

Sebelum anda melakukan
hal-hal di atas, ada bebe-
rapa kata yang harus disi-
mak berikut ini.

Cracking adalah seni modi-
fikasi suatu program dan
membuatnya bekerja se-
suai keinginan anda. Jika
anda mendapat free demo
program, lalu meng-crack
dan menggunakannya
untuk kepentingan sendiri,
maka anda di jalur yang
benar. Tetapi!! Jika anda
mulai menjual versi crack-
nya, maka ini adalah suatu
tidakan kkrriimmiinnaall.

Agar lebih jelasnya, ikuti
tutorial di halaman ber-
ikutnya langkah demi
langkah mulai dari men-
download  program tool,
menginstalasinya, men-
cari sasaran, disassembly
lalu modifikasi dan boom!
Anda telah menjadi
cracker.

PPeennuuttuupp

Sekarang kita telah mem-
pelajari arti dari kata
cracking, yaitu membuat
suatu program bertindak
seperti yang kita inginkan
dan bukan yang diingin-
kan oleh programmer dari
program tersebut. Kita ju-
ga telah mengenal dasar
dan tool yang popular
untuk cracking: WW3322DDaassmm
dan HHiieeww.

Sebelum mengikuti tutor-
ial di halaman berikutnya,
anda harus sudah men-
download tool-tool ter-
sebut. Kita segera akan
mempraktekannya dalam
langkah demi langkah
yang lebih detail sampai
anda berhasil meng-crack
sebuah software.

• Download W32Dasm di http://crackpltools.prv.pl dan dapatkan
informasi mengenai hacking dan cradcking di http://www.astalavista.com

• Betashark salah satu situs
yang menyediakan berbagai

jenis cracker’s tools.
http://www.betashark.f2s.com/

wapps.htm
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3 EKSTRAK ke Folder C:
Selanjutnya klik dua kali file
wdasm893.zip lalu klik Extract.
Kemudian klik folder C: lalu klik
New Folder dan ketik WDasm.
Sekarang klik All Files lalu klik
Extract.

NeoTutor

Cracking terhadap suatu
program adalah tidakan
‘mempereteli’ suatu file
aplikasi misalnya yang
berbentuk EXE menjadi
bahasa assembly dan di-

kenal sebagai disassembly (menggunakan
disassembler), kemudian mengubah kode-
kode aliran program sesuai dengan keinginan
kita menggunakan hex editor.

Disassembler-nya adalah WWDDaassmm dan hex
editor-nya adalah HHiieeww.. Dapatkan tool-tool
ini di situs-situs para cracker yang banyak
bertebaran di Internet (langkah 1–2) atau
dapatkan pada CD NeoTek bulan ini.

Selanjutnya instalasi disassembler WDasm
di hard disk anda (langkah 3–4) dan segera

PPAASSSWSWOORRD CD CRRAACCKKIINNGG
DDEENNGGANAN
DDIISSAASSSSEEMMBBLELER DR DANAN
HHEEX EX EDDIITTOOR (1)                R (1)                
Setelah sedikit tercerahkan dengan teori, sekarang langsung
saja anda duduk di depan PC. Buka NEOTEK, ikuti langkah
demi langkah penjelasan yang diberikan.

Jalankan W32dsm89
Selanjutnya klik dua kali W32dsm89
lalu klik menu Disassembler >
Open File to DIsassemble. Lalu
cari file EXE dari program Sweet
Little Piano yang akan di-crack,
yaitu Swlipi32 lalu klik Open.

Muncul Kode Assembly
Maka W32Dasm akan memuncul -
kan kode assembly dari file
Swlipi32.exe. Cobalah cari kata-
kata seperti Password, Sweet Little
Piano, Not a valid password!,
Thans for registering, dan lain-lain.

Download WDasm
WIndows32 Disassembler dapat
di-download di situs cracker:
http://crackpltools.prv.pl/ lalu
klik menu Disassemblers dan
segera klik aikon disket dari file
WDasm. Tentukan lokasi penyim-
panan hasill download lalu klik
Save

Download Hiew 
Sekarang download Hackers View
dengan meng-klik menu Editors
dan cari sub menu Hex Editors
lalu klik aikon disket di bawah
file Hiew. Letakan file ini didalam
folder yang sama dengan WDasm
agar mudah dicari.

1

7 8

2

Cara meng-crack password suatu program aplikasi

Cari String Data 
Untuk memudahkan pencarian,
klik menu String Reference yang
akan memunculkan window
W32Dasm List of String Data
Items. Cari kata-kata yang
berhubungan dengan password
dan registrasi. 

9
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Klik Dua Kali String Data
Ketemu? Biasanya kalau kita
berhasil memasukkan password,
maka akan muncul pesan seperti
Thanks for registering. Ada?
Oke! Sekarang klik dua kali string
data tersebut. Akan muncul kode
assembly untuk pesan tersebut!

Analisa Protection Routine
Sekarang kita analisa Protection
Routine mulai dari alamat
00401E39 sampai 00401E56.
Password Dialog… memanggil
GetDIgItemTextA.… test input…
dibandingkan...lalu lompat mele-
wati Thanks…dan dialog selesai.

Install Dari Folder WDasm
Kemudian klik Installer di folder
C:\WDasm> Pada window Siege
Installer, klik Select Directory >
Use Directory > Install > Install
Now >OK. Jika berhasil maka
akan muncul file application
W32dsm89.

Tentukan Target Sasaran
Download software yang akan di-
crack. Pada tutorial ini kita ambil
salah satu program musik yaitu
Sweet Little Piano. Download di
www.ronimusic.com/download.htm
Program ini akan membuat keyboard
anda menjadi alat musik.

4

10 11

5 Pelajari Tabiatnya!
Segera install dan jalankan program
Sweet Little Piano. Pada  window
Password, ketikkan karakter apa-
pun lalu klik OK. Apa yang terjadi?
Muncul window Sweet Little Piano
yang berisi kata-kata: Not a valid
password!.. Camkan tabiat ini.
Kalau perlu dicatat!

6

Lebih Detail
Perhatikan …test eax, eax…
artinya jika nilai kedua register
eax sama, maka instruksi jump je
dilakukan dan jika tidak sama maka
jump tidak dilakukan. Untuk meng-
crack program ini, ubah instruksi
je menjadi dua instruksi nop yang
artinya: no operation.

12

cari target program aplikasi yang ingin
anda preteli dan pelajari tabiat pro-
gram itu (langkah 5–6).

Langkah berikutnya adalah menja-
lankan WDasm dan bongkar program
aplikasi tersebut menjadi bahasa mesin/
assembly (langkah 7–8). Bahasa mesin
terdiri dari kode-kode angka heksa-
desimal yang hanya dimengerti oleh
si”idiot” prosesor komputer anda.

Bahasa assembly, adalah bahasa teren-
dah yang alur logikanya masih dapat
dimengerti. WDasm menyediakan
fasilitas interpreter yang memudahkan
kita memahami kode yang sesuai un-
tuk setiap instruksi assembly.

Langkah berikutnya adalah mencari
kata kunci yang direspon oleh pro-
gram aplikasi yang anda observasi
sebelumnya. Kata-kata kunci itu mi-
salnya “Bad Password,”“Not Registered,”
atau “Thanks for registering.” Kata-
kata ini akan keluar pada saat anda
mencoba memasukkan suatu password.

WDasm menyediakan fasilitas untuk
melakukan pencarian ini dan hal ini
disebut pencarian String Data. Bila
string data telah ketemu, lakukan kon-
versi ke bentuk instruksi assembly
(langkah 9–10).

Selanjutnya telusuri instruksi-instruksi
dengan mencoba mengujinya. Misal-

nya instuksi “jne,” yang akan mem-
buat lompatan ke alamat tertentu bila
input yang dimasukkan tidak sama
dengan suatu nilai tertentu. Dan
WDasm dapat melakukan lompatan
ini denga meng-klik tombol menu
“Jump to.” Hal ini disebut analisa
protection routine (langkah 11–12).

Carilah instruksi routine yang meru-
pakan kunci untuk membuka gembok
password (dilanjutkan ke halaman
berikutnya).
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15 CARI CRACK HIEW_V6.76
Silahkan cari di situs-situs search
engine underground antara lain
adalah www.astalavista.com. Kami
juga menyediakannya dalam CD
NEOTEK. Segera extract di folder
Hiew. 

NeoTutor

Sekarang kita lanjutkan.
Setelah berhasil mene-
mukan sepotong in-
struksi (langkah 11–12),
ikuti langkah berikut
ini. Pada langkah 12,

catat pesan yang tertulis pada bar bagian
bawah yang diawali dengan “Line 24…”
Dalam pesan ini tertulis alamat offset un-
tuk kode yang sedang anda sorot dengan
menggunakan keyboard. Selanjutnya anda
simpan kode assembly ini (langkah 13).

Saatnya sekarang tool HHiieeww berperan ka-
rena kita akan mulai untuk mengedit kode-
kode assembly yang telah ditemukan pada
langkah 12. Extract Hiew pada lokasi ter-
tentu dan segera crack versi trial version

PPAASSSWSWOORRD CD CRRAACCKKIINNGG
DDEENNGGANAN
DDIISSAASSSSEEMMBBLELER DR DANAN
HHEEX EX EDDIITTOOR (2)R (2)
Setelah menemukan sepotong kode kunci dari “protection
routine,” apa yang harus dilakukan? Ikuti terus tutorial langkah
demi langkah ini sampai anda berhasil membuka gembok
tanpa mematahkan anak kuncinya.

Modifikasi Kode ‘je’ ke ‘nop’
Kemudian tekan F3 lalu ganti kode
74 menjadi 90 dan 1E juga
menjadi 90. Kenapa 90? Karena
90 adalah kode untuk instruksi
nop. Lalu tekan F9 kemudian
tekan F10. 

Muncul Kode Assembly
Sekarang jalankan program Sweet
Little Piano. Pada window Enter
your password… ketikkan semba-
rang karakter lalu klik OK. Hasilnya?
Wow!! Thanks for registering!
Sekarang program ini telah menjadi
milik anda sepenuhnya.

Simpan Kode Assembly
Sekarang simpan kode assembly
itu dengan meng-klik Save
Disassembly Text File and Create
Project File. Lalu pada window
Save As, klik OK.

Extract Hiew676
Sekarang extract file Hiew676.zip
ke dalam folder Hiew. Hanya ada
aplikasi Hiewdemo yang bisa
dijalankan tetapi tidak bisa untuk
melakukan editing kode. Untuk itu
harus mencari full version-nya.

13

19 20

14

Cara meng-crack password suatu program aplikasi (bagian kedua)

Play The Music Guys!!
Untuk menikmati hasil jerih payah
anda, mainkan musik dari tuts
keyboard anda. Klik Midi dan piih
alat musik kesukaan anda: gitar,
piano, brass, perkusi atau applause
yang meriah untuk anda.

21
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Alternatif: ‘je’ ke ‘jne’
Sekarang kita coba cara lain yaitu
dengan mengubah instuksi je
menjadi kebalikannya yaitu jne.
Kalau je adalah jump if equal
maka jne adalah jump if not
equal. Kode untuk jne adalah 75.

Seteguk Air di Lautan Informasi
Agar lebih canggih trik yang anda
pakai, carilah situs-situs tutorial
tentang cracking software yang
berisi tuntunan yang paling mudah.
Salah satu yang kami anjurkan
adalah www.totse.com

Jalankan CAH32
Klik dua kali file CAH32, maka
muncul window seperti diatas.
Tekan Y terus sampai restore
processing OK semua sehingga
window akan tertutup secara
otomatis. Sekarang Hiew676
menjadi full version.

Jalankan HIEW32
Sekarang klik dua kali file Hiew32,
dan Hiew32 full version berjalan.
Kemudian pilih UP DIR dan tekan
Enter lalu cari Sweet Little Piano
32 dan tekan Enter. Selanjutnya
pilih Swlipi32.exe dan tekan Enter.

16

22 23

17 Cari Lokasi “je” di Swlipi.exe
Kemudian tekan F4 lalu pada
window Select moed, tekan Hex.
Sekarang tekan F5 lalu ketikkan
00001648. Ini adalah alamat
instruksi je di W32Dasm. Disitu
tertulis:@offset 00001648h in
File:Swlipi32.exe (lihat gambar di
langkah 12)

18

CRACKPL TOOLS
Ada banyak situs cracker, salah
satunya adalah Crackpl Tools di
http://crackpltools.prv.pl/
Anda bisa mendapatkan alat-alat
yang diperlukan untuk meng-
crack suatu program di sini.

24

ini dengan crack patch lalu jalankan
secara full version agar bisa dipakai
untuk melakukan penulisan kode
(langkah 14–17).

Kemudian lanjutkan dengan mencari
kode kunci yang telah ditemukan pada
langkah 12 di dalam file EXE dalam
aplikasi yang sedang di-crack. Ingat
alamat offset yang telah anda tulis
pada langkah 12 tersebut karena seka-
rang diperlukan (18).

Bila anda sudah dengan alamat offset
itu, segera lakakan modifikasi dengan
mengubah kode tersebut (langkah 19).
Inilah kegunaan dari tool Hiew, yaitu
mengubah langsung kode ke dalam
file EXE!

Sekarang jalankan dan ketikkan pass-
word yang diminta dengan mengetik
apa saja  dan jreenngg… “Thansk for
registering!” Senang? Tentu! Sebagai
pelampiasannya, mainkan software
yang telah anda crack ini (langkah
20–21).

Ada baiknya anda coba pemecahan
alternatif seperti dijelaskan pada lang-
kah 22 sehingga anda akan semakin
yakin. Semua program software yang
menggunakan protection routine
password akan mempunyai bentuk
pemecahan seperti ini. Dan kuncinya
adalah instruksi “test eax, eax” yang
diikuti dengan “je.” Ada dua cara
untuk membongkarnya yaitu dengan

mengubah “je” menjadi “nop” atau
instruksi kebalikannya yaitu “jne.”

Sebagai informasi tambahan, kami
berikan dua link ke situs yang ber-
guna untuk anda belajar lebih lanjut.

Happy cracking!

www.totse.com

crackpltools.prv.pl 

KLIK DI SINI
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Untuk menjadi hacker katanya harus menguasai telnet terlebih dahulu.
Sebenarnya telnet sekedar tool untuk mengakses komputer lain dari jauh.
Fasilitas yang tadinya hanya ada di Unix itu kini tersedua pula pada
Windows. Kali ini Onno W. Purbo membahas cara ber-email dengan
menggunakan telnet

ELNET ADALAH PROGRAM UNTUK MEMASUKI KOMPUTER
lain di jaringan komputer, awalnya telnet hanya ada
di UNIX dan turunannya, tapi saat ini terdapat juga

di MS Windows dan dapat di akses melalui DOS prompt.
Sebagai contoh, saya menggunakan Windows PC di rumah
yang tersambung ke LAN 100Mbps untuk memasuki server
Linux gate.yc1dav.ampr.org pada IP 192.168.0.1, maka mela-
lui perintah:

Microsoft(R) Windows 98
(C)Copyright Microsoft Corp 1981-1999.

C:\WINDOWS\Desktop>telnet 192.168.0.1

Akan muncul tampilan Telnet yang kemudian dengan
memasukan username & password, saya akan masuk ke
server Linux yang ada.

W elcome to gate.yc1dav.ampr.org
Linux Mandrake release 8.0 (Traktopel) for i586
Kernel 2.4.3-20mdk on an i586
login: onno
Password:xxxxxxxxx
Last login: Wed Aug  8 08:28:27 on :0
[onno@gate onno]$
[onno@gate onno]$

Tentunya anda dapat saja melakukan telnet ke mesin-mesin
lain di Internet & jaringan komputer lainnya jika telepon
anda tersambung ke Internet.
Servis di jaringan komputer Internet yang berbasis
protokol TCP/IP di identifikasi melalui berbagai port-nya.
Untuk mengirim e-mail biasanya kita menggunakan
Simple Mail Transport Protocol (SMTP) yang bekerja pada
port 25. Untuk membaca / mengambil biasanya digunakan

Post Office Protocol (POP) yang bekerja pada port 110.
Biasanya kita menggunakan software seperti Outlook
Express, Eudora yang sudah menggunakan Grafik User
Interface (GUI) untuk ber-e-mail ria, tapi sebetulnya dasar
kerja dari Outlook Express, Eudora dll ini sangat
sederhana & dapat kita imitasi secara manual
(menggunakan tangan di tik) menggunakan Telnet ke port
25 & 110.
Dalam skenario berikutnya, kita akan mencoba mengirim-
kan e-mail dari alamat e-mail imejiner kiddie@lamer.com
yang ditujukan ke alamat e-mail mailmu@yahoo.com.
Maka kita harus men-telnet mail server pada port 25
dengan perintah di bawah ini.

Microsoft(R) Windows 98
(C)Copyright Microsoft Corp 1981-1999.

C:\WINDOWS\Desktop>telnet 192.168.0.1 25

Rekaman ketikan manual pada saat tersambung ke port 25
tampak pada cuplikan di bawah ini.

220 gate.yc1dav.ampr.org ESMTP Postfix (Release-20010228)
(Linux-Mandrake)
HELO lamer.workstation.com
250 gate.yc1dav.ampr.org
MAIL FROM: <kiddie@lamer.com>
250 Ok
RCPT TO: <mailmu@yahoo.com>
250 Ok
D ATA
354 End data with <CR><LF>.<CR><LF>
From: kiddie@lamer.com
To: semaugue@apaaja.com
Subject: iseng ah

T

Menggunakan Menggunakan TTelnetelnet
untuk e-mail secuntuk e-mail secarara  manuala  manual
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Cuma sekedar ngiseng ngetest ngirim e-mail
cara manual pakai telnet ke port 25

Sekian dulu

.
250 Ok: queued as CCA4D1E7F
quit

Perhatikan semua kalimat yang di awali angka 220, 250,
354 adalah perintah-perintah uyang dikirimkan oleh mail
server ESMTP yang berjalan di Linux Mandrake 8.0. Perin-
tah HELO, MAIL FROM, RCPT TO, DATA dan terakhir
adalah "." (titik) semua di tik secara manual oleh saya
untuk mengirimkan e-mail melalui e-mail server. Perha-
tikan dalam berita yang saya kirim isi e-mail di To: tidak
sama dengan di RCPT TO: hal ini boleh-boleh saja untuk
membingungkan si penerima.
Semua tata cara penulisan ini merupakan tata cara komu-
nikasi untuk mengirimkan e-mail yang di dokumentasikan
di Simple Mail Transport Protocol (SMTP) yang dapat
dibaca pada Request For Comment (RFC) di Internet
(http://www.internic.net atau http://www.ietf.org). Perha-
tikan bahwa mailmu@yahoo.com akan menerima seluruh
teks yang kita tulis sesudah angka 354 hingga kita menu-
liskan "." (titik) yang berdiri sendiri.
Anda dapat mencoba ini di SMTP server ISP anda, yang
masih mengijinkan anda untuk merelay mail anda ke
Internet. Harap berhati-hati karena semua transaksi anda
melalui mail server ISP anda akan di catat (di log) oleh
server, jadi sebaiknya jangan melakukan spamming atau
hal yang tidak baik.
Dalam skenario selanjutnya, mari kita mencoba membaca
e-mail di POP server. Saya akan memperagakan membaca
e-mail user lamer dengan password lamer di POP server
192.168.0.1 yang dapat di ambil dengan perintag RETR
(retrive) di Post Office Protocol (POP) yang standby pada
port 110. Dengan perintah telnet ke port 110,
Mengikuti petunjuk dari W3C, CSS telah berkembang
selama beberapa tahun terakhir ini. Browser-browser
mutakhir mendukung CSS yang mutakhir pula.

Microsoft(R) Windows 98
(C)Copyright Microsoft Corp 1981-1999.

C:\WINDOWS\Desktop>telnet 192.168.0.1 110

Selanjutnya adalah rekaman interaksi dengan POP server
pada saat mengambil mail untuk user lamer dengan
password lamer.

+OK POP3 gate.yc1dav.ampr.org v2000.69mdk server ready
user lamer
+OK User name accepted, password please
pass lamer
+OK Mailbox open, 1 messages
list
+OK Mailbox scan listing follows
1 448
.
retr 1
+OK 448 octets
Return-Path: <root@gate.yc1dav.ampr.org>
Delivered-To: lamer@gate.yc1dav.ampr.org
Received: by gate.yc1dav.ampr.org (Postfix, from userid 0)

id C292E1E85; Wed,  8 Aug 2001 08:33:37 +0700 (JAVT)
To: lamer@gate.yc1dav.ampr.org

Subject: testing ...
Message-Id:
<20010808013337.C292E1E85@gate.yc1dav.ampr.org>
Date: Wed,  8 Aug 2001 08:33:37 +0700 (JAVT)
From: root@gate.yc1dav.ampr.org (root)
Status:

ini hanya sekedar test saja ..
.
dele 1
+OK Message deleted
quit
+OK Sayonara

Perhatikan bahwa POP server hanya meresponds dengan
+OK jika perintah yang diberikan benar. Perintah user,
pass, list, retr, dele, quit merupakan perintah-perintah
POP server yang kita ketik pada saat mengambil e-mail.
Semua perintah di dokumentasikan di naskah Post Office
Protocol (POP) 3 yang ada di Request For Comment
(RFC) di Internet seperti (http://www.internic.net atau
http://www.ietf.org ).
Tampak bahwa sebetulnya tata cara kerja Internet tidak
terlalu sulit, bahkan cenderung sangat sederhana &
sebagian besar dapat di kerjakan manual menggunakan
tangan jika anda rajin. Program hanya membuat semua
prosesa menjadi lebih automatis & memudahkan
pengguna biasa. Dengan cara yang sama anda bisa
melakukan eksplorasi cara kerja protocol-protocol lainnya
yang menjadi tulang punggung kerja Internet. Sebagian
besar protokol (tata cara komunikasi) di Internet di
kerjakan oleh rekan-rekan di Internet Engineering Task
Force (IETF) http://www.ietf.org. NNTT
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asilitas pada Unix shell account
gratis anda di Freeshell.org
(sdf.lonestar.org) adakah email

account. Karena ini adalah Unix shell,
anda harus menggunakan email client
yang lazim di Unix. Dalam hal ini
adalah software PINE.

Untu mengakses Unix shell account
anda dapat digunakan software telnet,
baik itu bawaan Windows, ZOC Ter-
minal Emulator, ataupun software
telnet lainnya.

Sebelum dapat menggunakan PINE,
anda  akan mendapatkan email account
di Unix shell ini.

Selamat datang di dunia Unix!

F

4

10 11

5 6

12KIRIM EMAIL
Untuk berlangganan milis, memang
cukup kirim email kosong saja.
Tekan Ctrl-X untuk mengirimkan
email kosong ini. Akan tampil
pertanyaan Send message? dengan
pilihan Y (Yes), N (No), dan Ctrl-C
(Cancel). Pilih Y.

JAWABAN DARI YAHOOGROUPS
Pada folder Inbox sudah terlihat ada-
nya pesan email baru untuk anda.
Kali ini dari yahoogroups mengenai
permintaan anda menjadi anggota
milis NeoTek yang meminta anda
mengkonfirmasi permintaan berlang-
ganan anda pada milis ini.

PESAN TERKIRIM
Pesan sudah terkirim dan anda
kembali ke daftar menu. Pesan yang
anda kirim itu disimpan dalam
foldfer “send-mail.” pilih L (Folder
List) untuk melihat macam-macam
folder yang ada pada PINE. 

Email account anda di Freeshell.org dan mencicipi Pine, email client untuk Unix

PPIINNEE
EEMAIMAIL DL DEENNGGAN TAN TEELNLNEETT
PPADADA UA UNNIIX SX SHHEELL ALL ACCOCCOUUNNTT

FOLDER EMAIL TERBENTUK
Sekarang coba anda putuskan koneksi
ZOC Terminal kemudian login lagi.
Coba ketik ls dan satu direktori
tambahan telah terbentuk yaitu mail.
Dalam direktori mail ini akan
tersimpan antara lain sent mail dan
saved messages. 

MAIN MENU PINE
Lihat Main Menu program email dari
Pine. Ketik pine setelah prompt $.  Ada
tujuh menu utama di sini: HELP, COM-
POSE MESSAGE, MESSAGE INDEX,
FOLDER LIST, ADDRESS BOOK, SETUP
dan QUIT. Jelas maksud masing-masing
menu ini bukan? Di sini keyboard yang
berperan.

Sudah mempunyai Unix Shell Account sendiri di Freeshell.org?
Selain sebagai web hosting serta untuk menjalankan software-
software Unix, tersedia pula fasilitas email. Kini pengguna
Windows dapat juga mencicipi Pine, software email yang dulu
hanya tersedia untuk pengguna Unix.

MELIHAT EMAIL YANG MASUK
Untuk melihat email yang masuk, ketik
L dan Enter. Akan terlihat pesan untuk
anda sebagai pengguna baru PINE versi
4.33 ini. Untuk membukanya tekan
Enter atau >. Ingat, karakter > dimun-
culkan dengan menekan tombol Shift
lalu tombol > sesuai dengan aturan
keyboard anda.
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7

13 14

8 9
EMAIL ANDA YANG PERTAMA
Dari main menu pilih C (Compose)
untuk menuliskan pesan email anda
yang pertama dengan menggunakan
PINE pada unix shell account anda di
Freeshell.org ini.

15
QUIT DAERI PINE
Untuk keluar dari PINE, cukup ketik-
kan Q (Quit) dan akan tampil pesan
‘Really quit pine?’ Pilih Y (Yes) untuk
keluar dari PINE dan anda kembali
ke prompt $ dari Unix shell account
anda.

3
ACCOUNT EMAIL ANDA
Nah, anda baru saja mengaktifkan
pine dan responnya adalah
munculnya Greeting Text seperti
gambar di atas. Tertulis bahwa pine
adalah milik University of Washington,
USA. Tekan Return/Enter

INFORMASI UNTUK PEMAKAI BARU
Isi email ini adalah tip untuk pemakai
baru program PINE. Eh… ada juga
promosi sticker Freeshell. org untuk
dipasang di bumper mobil anda. Ketik
O (Other Command) untuk memilih
fungis lain dari menu yang ada.

KIRIM KE MILIS NEOTEK
Kirim ke milis NeoTek, misalnya untuk
menjadi anggota baru di milis ini ke
majalahneotek-subscribe@yahoogroups.com
Perhatikan footer pada setiap email
anda, tertera SDF Public Access Unix
system - http://sdf.lonestar.org. Pesan
untuk teman-teman bahwa anda sudah
punya Unix shell account. Keren bo!

BACA ISI EMAIL
Email ini meminta anda membalas
email ini untuk konfirmasi bahwa
anda memang berminat menjadi
anggota milis Majalah NeoTek. Pilih
R (Reply) untuk membalas email
ini ke administrator yahoogroups.

KIRIM EMAIL BALASAN
Email balasan ini tidak perlu diisi
apa-apa. Cukup langsung kirim saja
dengan memilih Ctrl-X (Send) dan
anda akan kembali ke menu utama
PINE.

2
MENGAKTIFKAN EMAIL ACCOUNT
Untuk mengaktifkan Program email
ini, ketik pine dan tekan Enter.  Untuk
mengujinya, coba ketik ls sebelum
anda mengetik pine. Hanya ada satu
direktori yaitu html. Coba test lagi
setelah pine diaktifkan dan hasilnya
akan muncul direktori mail

1
INFORMASI PADA ‘HELP’
Setelah anda berhasil masuk dengan
login dan password, ketik help sete-
lah prompt $. Cari perintah untuk
menerima dan mengirim email yaitu
pine. 
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Sistem operasi Linux merupakan sistem generasi baru yang dibuat
oleh programmer generasi baru dengan cara baru, yaitu kerja bareng
dengan berbagi free source code. Namun membawa stabilitas dari
sistem operasi yang sudah lama digunakan, yaitu Unix.

PA HUBUNGANNYA LINUX DENGAN
Unix. Apa yang dimaksud de-
ngan free pada Linux? banyak

yang mengira bahwa free artinya gratis.
Terjemahan tepatnya adalah bebas. bu-
kan gratis. Bebas mendapatkan kode sum-
bernya, bebas mengubah-ubah sesuai
keperluan, dan bebas membentuk file
distribusi sendiri.

Linux adalah suatu sistem operasi se-
jenis Unix atau POSIX compliant (PO-
SIX adalag standar pada Unix) yang di-
kembangkan oleh Linus Torvalds. Linux
berjalan pada berbagai jenis platform
mulai dari PC, Mac, sampai Sun Sparc.

Linus Torvalds yang pada tahun 90-
an awal adalah mahasiswa computer
science di Universitas Helsinki di Fin-
landia mengembangkan sistem operasi
dari kode-kode sumber yang tersedia
bebas, yaitu kode-kode sumber Unix.

Ia tidak banyak mengenal programmer,
sehingga ia meminta bantuan mereka
untuk proyeknya melalui newsgroup.
Untuk pengembangan proyek ini, kode

sumber disediakan terbuka dan meru-
pakan bagian dari konsep open-source.

Falsafah meminta komentar dari pema-
kai dan menyediakan kode sumber be-
bas ini sebenarnya bukanlah gagasan
baru. Richard Stallman dari MITsudah
memperkenalkan konsep free software
ini sejak tahun 1970 dan kemudian
mengembangkan ‘free software’ yang
berarti ‘freedom’ bukan ‘zero cost.’

Tahun 1984, karena merasa tak dapat
mengembangkan konsep ‘free software’
di MIT, Richard Stallman keluar dan
mendirikan GNU yang bertujuan me-
ngembangkan software yang bebas di-
gunakan, didistribusi, dan dimodifikasi.

Sasaran Linus Torvalds enam tahun ke-
mudian pada dasarnya sama: mengem-
bangakn sistem operasi yang mendapat-
kan umpan balik dari pemakainya.

Sistem Operasi dan Kernel
Fokus dari suatu sistem operasi adalah
kernel. Kernel yang memberitahu chip

komputer apa yang harus dilakukan
berdasarkan permintaan dari program.

Tanpa kernel, suatu sistem operasi pada
dasarnya tidak ada, dan tanpa program
suatu kernel tidak ada gunanya.

Pada tahun 1991 sudah saatnya men-
ciptakan suatu sistem operasi. Linus
Torvalds mempunyai kernel tetapi
tidak mempunyai programnya sendiri,
sedangkan Richard Stallman mempu-
nyai program tetapi tidak mempunyai
kernel yang berfungsi.

Demikianlah dengan mengkombinasi-
kan program-program yang ada pada
GNU di Cambridge, Massachusetts
dengan kernel yang dikembangkan
oleh Linus Torbalds di Helsinki, lahir-
lah Linux.

Karena adanya masalah jarak, pengem-
bangan Linux sejak awal sudah meman-
faatkan Internet yang pada waktu itu
masih dalam bentuk awalnya. Para
programmer yang mempunyai keahlian
tinggi yang membantu dalam proyek

A

Memahami Memahami LinuxLinux
Unix dan Linux untuk PUnix dan Linux untuk Pemakai Windoemakai Windowsws

• Sistem operasi berdasarkan POSIX
(standard pada Unix)

yang bukan Linux dan dikembangkan oleh
perusahaan/organisasi lain:

Sun Solaris, Mac OS X.,
FreeBSD, OpenBSD, dan NetBSD.

Masing-masing menggunakan
propretiary technology

dari masing-masing pengembang
yang menjadikan Unix

bukan lagi sistem operasi
yang bersifat universal.
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Linux ini sehingga sampai sekarang
kesan bahwa Loinux adalah untuk para
‘suhu’ saja tidak dapat dielakkan.

Linux adalah suatu sistem operasi dari
keluarga Unix. Walaupun kode sum-
bernya sama, Unix jauh dari kesera-
gaman. Perusahaan-perusahaan besar
memaksakan versi Unix-nya sendiri
yang tidak kompatibel satu sama lain.
Sistem-sistem operasi jenis Unix yang
merupakan alternatif terhadap Linux
di antaranya adalah:
• Sun Solaris
• Mac OS X
• FreeBSD
• OpenBSD
• NetBSD

Linux, walaupun juga tersedia dalam
berbagai ‘rasa’ tetap kompatibel satu
sama lain. Ini dikarenakan semua ‘rasa’
Linux itu menggunakan kernel yang
sama.

Jenis-jenis Distribusi Linux
Berbagai ‘rasa’ Linux dapat dikelom-
pokkan dari kemudahan instalasinya.

Mudah Diinstalasi
• Mandrake
• Red Hat
• SuSE
• Caldera
• TurboLinux

Lebih Sulit Diinstalasi
• Slackware
• Debian

Untuk Mesin Lain
• Linux untuk Macintosh

Instalasi Distribusi Linux
Instalasi berbagai ‘rasa’ Linux, pada
prinsipnya mengikuti tapa-tapa yang
sama sebagai berikut:

• Kenali komputer tempat Linus akan
diinstalasi, termasuk semua yang di
dalamya. VGA card, modem, mouse,
monitor. Semuanya

• Dapatkan manual dari setiap kom-
ponen itu (sekarang informasi dapat
diperoleh juga dari Internet).

• Membuat dual-boot system
• Membuat partisi
• Windows pada partisi primer
• LILO (linux loader)

• Instalasinya itu sendiri 
• base programs needed 
• programs you might want

• Mencatat masalah dalam instalasi 
• Kemana mencari bantuan bila tidak

berhasil? (Linux User Group) 
• Setelah instalasi berhasil

• Mengkonfigurasi x-windows
• Apa itu xfree86? 
• Apa itu windows manager? 
• Mau pakai window manager apa?
• Mengkonfigurasi kernel yang baru

Linux/Unix pada Windows
Selain itu terdapat pula Linux yang diin-
stalasi langsung dari Windows, sehingga
tidak perlu memusingkan partisi. Mem-
buat partisi ini adalah hambatan yang
paling utama bagi yang sudah terbiasa
menggunakan Windows.

Contoh Linux yang diinstalasi lang-
sung melalui Windows adalah:

• Armed Linux
• WinLinux 2000

Selain itu anda dapat pula menginstalasi
software yang mengemulasi Unix pada
Windows. Software ini, Cygwin, dikem-
bangkan agar para pemakai Unix dapat
terus memakai utilitas-utilitas yang me-
reka biasa gunakan dalam Unix sewaktu
mereka bekerja pada Windows.

NeoTek kali ini membahas Armed Linux
dan Cygwin. yang satu sebagai sistem
operasi Linux yang diinstalasi langsung
lewat Windows dan satunya lagi adalah
‘Unix look and feel’ pada Windows.

Selamat mencoba Linux!

• Macam-macam flavour (‘rasa’) Linux yang
kesemuanya menggunakan kernel yang sama

sehingga kompatibel satu dengan lainnya.

• WinLinux 2000, salah satu versi Linux yang
dapat diinstalasi langsung dari Windows.

Untuk menjalankannya harus melalui
DOS (bukan emulasi DOS).

Kini WinLinux 2000 telah menyediakan
fasilitas untuk membentuk startup disk

pada Windows ME sehingga dapat
boot mesin langsung ke WinLinux 2000

tanpa harus melalui Windows ME lagi.
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ed Hat 7.1 dapat di-boot lang-
sung dari CD dan membentuk
partisi sendiri pada komputer

yang sudah ada DOS/Windows-nya.
Namun bila kapasitas hard disk tidak
memadai, tetap saja harus manual.

Armed Linux diinstalasi sebagai pro-
gram Windows dan dijalankan lewat
prompt DOS (pada ME tidak bisa
sebab hanya emulasi DOS) dan anda
pun mendapatkan Linux lengkap
dengan X Windows (bukan cuma
command promt).

Uninstall-nya cukup dengan meng-
hapus direktorinya lewat Windows
Explorer. Mudah bukan?

ARARMMEED LID LINNUUXX
IINNSSTTALALAASSI LII LINNUUXX
LLANANGGSSUUNNG DG DI WI WIINNDDOOWWSS
Hambatan utama pemakai Windows untuk mulai belajar Linux
adalah keharusan menyediakan partisi khusus untuk sistem operasi
baru ini. Kini ada versi Linux yang diinstalasi langsung pada Windows
dan di-boot langsung lewat DOS prompt. Itulah Armed Linux.
Uninstall-nya pun semudah menghapus folder Windows.

R

File untuk Konfigurasi Display
Setelah berada di dalam direktori
/usr/X11R6/bin ini, ketikkan ls dan
perhatikan dua file yaitu xf86config
untuk mengkonfigurasi mouse,
keyborad, screen, dan VGA card
serta startx untuk menjalankan X
Windows setelah konfigurasi selesai

Jalankan xf86config
Jalankan xf86config dengan me-
ngetikkannya pada command
prompt. Akan tampil informasi
bahwa anda akan membentuk
file dasar XF86Config berdasar-
kan piliahan-piliahan anda. Tekan
<enter> untuk melanjutkan.

Menjalankan armed linux
Pada prompt DOS, masuk ke folder
Armed Linux dengan mengetikkan
cd\armed lalu ketikan armed untuk
menjalankan batch file yang akan
menjalankan loadlin, uncompress dan
mem-boot Linux kernel, dan meng-
konfigurasi dan menjalankan kom-
ponen-komponen Linux.

Login Sebagai Root User
Anda akan mendapatkan command
line Linux yang meminta anda
login untuk pertama kali. Ketikkan
root dan password-nya armed.
Selanjutnya sistem akan meminta
anda mengubah password itu
untuk login di masa medatang.

4

10 11

5

Instalasi Linux kini (hampir) semudah instalasi program biasa di Windows

Informasi Monitor dan VGA Card
Sebelumnya anda harus menge-
tahui dulu HSync dan VSync dari
monitor yang dipakai serta tipe
dari Chip set yang digunakan pada
VGA card serta berapa RAM pada
VGA card itu. Dapatkan dari buku-
nya atau search dari Internet. 

12

Ganti Root Password
Isikan password yang baru untuk
user root ini. Jangan sampai lupa.
Bila lupa anda harus menghapus
direktori C:|Armed dan instalasi
ArmedLINUX dari awal lagi (dengan
semua data hilang tentunya). Bila
sound card anda bukan PCI maka
harus disetting secara manual. 

Please specify a NEW root password.
You will need this password everytime you logon as root!
Changing password for user root
New Unix password: _

ArmedLINUX Workstation V1.1b
(Belmadino)
You Are Running Kernel 2.2.11 on an i586

ArmedLINUX Login:root
Password:

fstobdf startx xedit xmessage xwd
fvwm tksysv xev xmh xwininfo
fvwm2 twm xeyes xmixer xwud
gccmakedep vdcomp xf86configxlink
get-wraster-flag viewres xfd xmodmap
geticonset wdwrite xfindproxyxmorph
[root@ArmedLINUX /]# cd bin
[root@ArmedLINUX /bin]# _

[root@ArmedLINUX /bin]# xf86config

This program will create a basic XF86Config file, based
on menu selection you make.

Press enter to continue or ctrl-c to abort.

Microsoft(R) Windows 98
(C)Copyright Microsoft Corp 1981-1999.

C:\WINDOWS>cd\Armed
C:\Armed>armed
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Mengisikan Konfigurasi
Pertama kali akan ditanyakan ten-
tang mouse, lalu keyboard, monitor,
dan terakhir chip set VGA card anda.
Mouse dan keyboard relatif mudah
ditetapkan. Monitor memerlukan
informasi Hsync dan Vsync. Di
sini ini digunakan X Server(sejenis
driver) XF86_SVGA.

Link dan Video Memory
Jawab ‘y’ waktu ditanya apakah mem-
buat symbolic link ke X Server, lalu
isi besar memori VGA card. Clockchip
setting tidak dipilih, dan ketik ‘n’
untuk tidak menjalankan ‘X-probeonly.’
OK untuk mode yang dipilih dan
XF86Config akan ditulis ulang.

Lewati Konfigurasi Periferal
Lewatkan saja dulu. Anda akan
masuk ke setting layar dan VGA
card pada XFree86 setup. Masuk ke
command prompt dengan menge-
tikkan Ctrl-Alt-BkSpace. Anda kan
masuk command prompt Linux.

Tempelkan kode counter 
Naik ke direktori di atasnya de-
ngan mengetikkan cd .. (ada spasi
diantara cd dengan dua titik).
setelah itu ketikkan ls untuk
melihat isi direktori ini. Terlihat
ada direktori usr. Masuk ke
direktori itu dengan mengetikkan
cd user.

7

13 14

8
Save 
Lihat lagi isi direktori ini dengan ls.
tampak terdapat direktori X11R6.
Ini adalah direktori X Windows, GUI
(graphics user interface) pada Linux.
Masuk ke direktori itu dengan me-
ngetikkan cd X11R6 dan didalam-
nya ada lagi direktori bin.

9

Ini Dia X Windows
Kini dari command prompt ketikkan
startx dan akan tampil layar abu-
abu dan tak lama kemudian tampil
desktop X Windows. Bila gagal,
ketikkan Ctrl-Alt-Backsp untuk
kembali ke command prompt dan
ulang instalasi X server ini.

15

Masuk Situs Armed Linux
Arahkan browser anda ke Armed
Linux http://www.armed.net/
lalu download Armed Linux Beta
1.0 Workstation (186M) atau 1.1
(192M). Bila terlalu besar, dapat-
kan saja dari CD NeoTek bulan
ini. Sementara server belum ada.

Instalasi ke Direktori Armed
Instalasi file armwkb11.zip akan
menghasilkan direktori Armed di
hard disk anda (c:\Armed) yang
berisi batch file DOS, file Linux
Loader (loadlin.exe), swap file,
serta IMG file yang berisi Armed
Linux (armedsys).

1 2 Restart in MS-DOS Mode
Untuk menjalankan Armed Linux,
pilih Start > Shut Down dan pilih
Restart in MS-DOS mode pada
jendela dialog Shut Down Windows
dan anda akan masuk ke command
prompt Windows.

3

Your selected card definition:

Identifier: Trident 3DImage975 AGP (generic)
Chipset: 3dimage975
Server: XF86_SVGA
Do NOT probe clocks or use any Clocks line.

Press enter to continue, or control-c to abort

I am going to write the XF86Config file now. Make sure you don t accidently
overwrite a previously configured one.

Shall I write it to /etc/X11/XF86Config? y

File has been written. Take a look at it before running startx . Note that
the XF86Config file must be in one of the directories searched by the
server (e.g. /usr/X11R6/lib/X11) in order to be used. Within the screen
press ctrl, alt, and +  simultaneously to cycle video resolution. Pressing
ctrl, alt and backspace simulatneously immediately exits the server (use
if the monitor doesn t syncfor the particular mode).

For further configuration, refer to /usr/X11R6/lib/X11/doc/README.Config.

[root@ArmedLINUX bin]#  _

[root@ArmedLINUX /root]# _ [root@ArmedLINUX /root]# cd ..
[root@ArmedLINUX /]# ls
bin dev etc initrd lost+found proc sbin usr
boot dos homelib mnt root tmp var
[root@ArmedLINUX /]# cd usr
[root@ArmedLINUX /usr]#

[root@ArmedLINUX /root]# cd ..
[root@ArmedLINUX /]# ls
bin dev etc initrd lost+found procsbin usr
boot dos home lib mnt root tmp var
[root@ArmedLINUX /]# cd usr
[root@ArmedLINUX /usr]# ls
X11R6 doc i-386-glibc20-linuxinclude libexec sbin tmp
bin etc i-386-redhat-linux info local share
dict gamesi-386-linux-libc5 lib man src
[root@ArmedLINUX /usr]# cd X11R6
[root@ArmedLINUX /X11R6]# ls
bin doc include lib man share
[root@ArmedLINUX /X11R6]# cd bin
[root@ArmedLINUX /bin]# _
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asih kesulitan menginstalasi
Linux sendiri pada partisi khu-
sus di hard disk anda? Atau

unix shell anda membatasi kuota dan
apa yang boleh diinstalasi di sana?

Dengan Cygwin anda dapat memper-
oleh lingkungan unix terpasang pada
Windows. Cygwin terdiri dari file
CYGWIN1.DLL yang bertindak se-
bagai Unix emulation layer serta ko-
leksi tool yang di-port dari Unix;
membawa ‘look and feel’ Unix pada
PC Windows Anda.

Karena lengkapnya, ukuran download
amat besar. Bila tidak mempunyai
akses broadband, dianjurkan meng-
instalasi dari CD NeoTek.

M

SIMPAN DIMANA
Akan tampil jendela untuk menen-
tukan direktori tempat menyimpan
hasil download (Local Package
Directory). Pada contoh ini di
C:\Download\Cygwin. Setelah itu
tampil pilihan akses. Pilih Direct
Connection (bila akses internet di
warnet, pilih Use HTTP/FTP Proxy).

4

10 11

5 6

12

MEMULAI DOWNLOAD
Anda akan diminta memilih situs
download. Pilih saja salah satu,
misalnya di ftp://planetmirror.com
dan klik Next, maka download akan
dimulai dengan memilih apa yang
ingin di-download. Layar ini me-
mungkinkan download update dari
komponen tertentu saja.

DOWNLOAD SEMUA
Anda dapat memilih untuk mendown-
load file apa saja dan darui versi sebe-
lumnya (Prev), yang sekarang (Curr)
atau yang masih percobaan (Exp).
Pilih Curr dan klik tombol Full/Part.
Akan tampil daftar yang akan di-
download. Bila pada kotak pilihan
diklik X maka tidak di-download.

ROOT DIRECTORY CYGWIN
Selanjutnya akan tampil jendela
untuk menentukan root directory
Cygwin. Dalam hal ini C:/Cygwin
Perhatikan bahwa penulisan direktori
sudah mengikuti aturan Unix/Linux
yaitu C:/ dan bukannya C:\
Default file type pilih Unix dan Install
for All. Klik Next.

INSATALASI DALAM PROSES
Instalasi dari direktori lokal pun
memerlukan waktu cukup lama
nmengingat banyaknya Unix tools
yang diinstalasi. Memang dengan
Cygwin ini, anda akan memperoileh
‘look and feel’ Unix dan sekaligus
kelengkapan yang ada pada Unix.

PILIH APA YANG DI-INSTALL
Kembali tampil layar Cygwin Setup
yang memberi pilihan file-file apa
yang akan diinstalasi. Pilih Curr dan
klik tombol Full/Part. Terlihat
bahwa pilihannya banyak sekali
unix shell, tar program unzip pada
Unix, sampai postgresql. Selanjutnya
klik Next untuk memulai instalasi

Cygwin berjalan di semua versi Windows, kecuali Windows CE

CCYYGGWWIINN
MMEEMMBBAAWWA LIA LINNGGKKUUNNGGANAN
UUNNIIX PX PADADA WA WIINNDDOOWWSS
Anda dapat mendapatkan ‘look and feel’ Unix/Linux tanpa harus
menginstalasinya. Cygwin dari Red Hat Software memungkinkan
pemakai Windows menikmati berbagai software yang dikembangkan
dalam Unix/Linux pada Windows.
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DOWNLOAD BERJALAN
Klik Next dan download akan
berlangsung. Mengingat besarnya
file yang di-download, proses ini
memakan waktu cukup lama. Bila
anda tidak sabar menunggu
download ini, gunakan saja CD
NeoTek untuk menginstalasi Cygwin
dan ikuti mulai langkah 8 saja.

INSTALASI CYGWIN
Kembali klik dua kali icon setup
dan jendela Cygwin Setup akan
ditampilkan. Klik Next dan tampil
pilihan lagi. Ketiga pilihan yang
sama yaitu: Install from Internet,
Download from Internet, dan Install
from Local Directory.

DARI LOCAL DIRECTORY
Pilih Install from Local Directory
lalu klik Next. Akan tampil jendela
yang mencari lokasi Local Package
Directory. Dalam hal ini ada di
C:\Download\Cygwin. Bila anda
menginstalasi dari CD NeoTek,
direktorinya harus disesuaikan
dengan direktori pada CD itu.

INSTALASI SELESAI
Pada akhir instalasi anda akan diberi
pilihan apakah ingin menciptakan
Desktop Icon dan/atau menambah-
kan Cygwin pada Start Menu. Kita
pilih kedua-duanya. Instalsi pun
selesai! Klk OK.

MENJALANKAN CYGWIN
Cygwin dapat dijalankan dengan
meng-klik icon Cygwin pada desktop
atau dengan memilih Start >
Programs > Cygnus Solutions >
Cygwin Bash Shell. Kini anda
sudah mempunyai Unix/Linux shell
sendiri pada komputer Windows PC
anda!

UNIX LOOK AND FEEL
Akan tampil konsol Unix yang
ditandai dengan prompt khas $
Anda dapat mulai mencoba-coba
perintah-perintah dasar Unix/Linux di
sini. Untuk membuat direktori
ketikkan mkdir coba lalu ketikkan ls
untuk melihat direktori itu.

1 2 3
SAVE PROGRAM TO DISK
Akan tampil jendele File Download
dan anda diberi dua pilihan: men-
jalankan program dari lokasinya
atau menyimpannya pada disk. Kita
pilih yang kedua: Save this pro-
gram to disk. Tujuannya agar da-
pat menginstalasi di mesin lain lagi.

MENGINSTALASI CYGWIN
Kunjungi situs Red Hat Software, khu-
susnya halaman instalasi CYGWIN di
http://sources.redhat.com/cygwin/
Setelah membaca penjelasan
mengenai apa itu Cygwin, klik icon
yang bertuliskan Install Cygwin Now.

DOWNLOAD KE HARD DISK
Katakanlah di-save di direktori
C:\Download\Cygwin. Cari dengan
Windows Explorer dan double click
icon setup. Jendela Cygwin Setup
akan tampil. Klik Next. Akan tampil
pilihan: Install from Internet,
Download from Internet, dan Install
from Local Directory. Pilih download.
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ila pernah memakai DOS, ma-
ka perintah-perintah pada
Unix/Linux tidak terlalu men-

jadi masalah sebab banyak yang setara.

Kita akan mencoba membentuk pro-
gram permainan catur ggnnuucchheessss..eexxee
dari source code-nya. Source code itu
sendiri dapat di-download dalam
format terkompresicchheessss--55..0022..ttaarr..ggzz

Kita akan mulai dengan perintah tar
untuk mengekstrak source code
permainan catur ini, lalu membentuk
file konfigurasi ccoonnffiigguurree, file
mmaakkeeffiillee, dan membentuk file akhir
yang dituju, yaitu ggnnuucchheessss..eexxee

Selamat mencicipi ‘look and feel’
Linux!

B

SIMPAN DIREKTORY CYGWIN
Arahkan download ini agar hasil
download tersimpan di direktori
Cygwin, tepatnya di
C:\Cygwin\Home\NamaKomputer
yang dalam hal ini adalah
C:\Cygwin\Home\Kosasih Iskandarsjah

4

10 11

5 6
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DOWNLOAD SELESAI
Proses download akan memakan
waktu cukup lama, mengingat file
chess-5.02.tar.gz ini besarnya
hampir 31 megabyte. Bagi yang
segan men-download, dapatkan file
ini dari CD NeoTek.

JALANKAN CYGWIN
Start > Programs > Cygnus Solutions
> Cygwin Bash Shell untuk menjalan-
kan unix shell Cygwin. Tampak bahwa
anda kini berada pada root directory
yang ditandai dengan cedile (~).
Pada contoh KOSASIH adalah nama
komputer sedangkan Kosasih Iskan-
darsjah adalah folder root directory.

UNZIP SELESAI
Setelah proses unzip selesai, anda
dapat menggunakan Windows
Explorer untuk melihat hasilnya.
Tampak akan terbentuk folder
chess-5.02 yang mempunyai tiga
subfolder yaitu book, doc, dan src
Masuk ke subfolder doc untuk
melihat petunjuk instalasinya.

BUKA DENGAN WINWORD
Pilih Winword untuk membuka file
ini dan pelajari petunjuk selanjut-
nya untuk melakukan konfigurasi
dan kompilasi terdapat file-file yang
telah berhasil di-unzip tadi. File-file
ini semuanya merupakan source
code yang dari ini semua kita akan
membuat file exe-nya.

BUKA DENGAN WINWORD
Di dalam subfolder doc terdapat
beberapa file, di antaranya file
dengan nama INSTALL. Klik kanan
pada file ini dan pilih Open
With…

Mengenal perintah-perintah dasar Unix/Linux sambil belajar mengkompilasi source code

CCYYGGWWIINN
MMEENNCCIIPTPTAKAKAN FAN FIILE .ELE .EXXEE
DDARARI SI SOOUURRCCE COE CODDE UE UNNIIXX
Untuk mengenal perintah-perintah dasar Unix/Linux, kita buat suatu
proyek kecil yang perlu menggunakan perintah-perintah dasar Unix
seperti tar (untuk unzip file), ls (list), cd (change directory) sambil
melakukan proses konfigurasi dan pembentukan file (make).
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LIHAT ISI ROOT DIRECTORY
Untuk nelihat isi root directory ini,
pada prompt $ ketikkan ls (serupa
dengan perintah dir pada DOS) dan
akan tampak bahwa pada root
directory ini terdapat fil
chess-5.02.tar.gz hasil download

dari situs GNU tadi.

UNZIP CHESS-5.02.TAR.GZ
Untuk meng-unzip file ini pada
prompt $ ketikkan perintah berikuit:
tar -zxvf chess-5.02.tar.gz
Tampak bahwa perintah untuk
meng-unzip adalah tar, sedangkan
parameter-parameter diawali
dengan tanda minus (-) bukannya /

PROSES UNZIP BERLANGSUNG
Biarkan saja proses unzip
berlangsung. Anda akan melihat
langkah-langkah proses ini pada
layar, mulai dari membentuk
subdirectory sampai mengekstrak
file-file ke masing-masing direktori.

KEMBALI KE CYGWIN
Karena kita berada pada root
directory Cygwin, maka pertama kali
kita harus masuk dulu ke direktori
src. Untuk itu dari prompt $ ketikkan:
cd chess-5.02 <enter>
cd src <enter>
Terlihat perubahan direktorinya.

KONFIGURASI OTOMATIS
Jalankan konfigurasi dengan menge-
tikkan autoconf pada prompt $.
Perintah ini akan membentuk file
configure dari configure.in
Anda akan kembali mendapatkan
prompt $ dan kini siap untuk proses
berikutnya.

JALANKAN CONFIGURE
Jalankan configure dengan menge-
tikkan ./configure dari prompt $.
Proses pembentukannya akan
ditampilkan pada layar dan
menghasilkan file Makefile dari
Makefile.in Setelah ini tinggal satu
langkah lagi yaitu perintah make
untuk membentuk gnuchess.exe

1 2 3
FREE SOFTWARE DIRECTORY
Klik Free Software Directory dan
dari sini pilih Games. Terdapat
macam-macam game dan untuk
contoh kita di sini, pilih chess
(permainan catur).

CARI SOFTWARE SERUPA UNIX
Untuk mendapatkan software serupa
Unix, arahkan browser anda ke situs
GNU di http://www.gnu.org/. GNU
yang mulai berkiprah sejak tahun 1984
ini menyediakan freeware yang serupa
dengan Unix. Kini ada banyak varian
GNU yang berjalan di kernel Linuxx

DOWNLOAD SOURCE FILE
Download source file chess yaitu
chess-5.02.tar.gz yang merupakan
file zip dalam Unix/Linux.
Klik  link-nya di ftp server, yaitu di
ftp://ftp.gnu.org/pub/gnu/chess/c
hess-5.02.tar.gz dan pilih Save this
file to disk.
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etelah menjalankan aauuttooccoonnff
akan terbentuk configure
dari configure.in. Selanjut-

nya configure ini dijalankan untuk
membentuk makefile dari makefile.in.

Tahap berikutnya adalah membentuk
gnuchess.exe dengan menjalankan
perintah make.

Sampai di sini gnuchess.exe sudah
dapat dimainkan. Untuk menambah
‘otak’ program ini, perkaya informasi
tentang permainan pada book.dat de-
ngan menambahkannya dari book.pgn
dengan perintah bbooookk  aadddd  bbooookk..ppggnn

Coba deh!

S

MENGUJI KEDALAMAN ANALISA
Setelah gnuchess dijalankan akan
tampil prompt
White(1):
ketikkan post <enter> lalu
depth <enter>
untuk search solusi 8 tingkat

4
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JALANKAN ANALISA
Untuk menjalankan analisa 8 tingkat
itu, pada prompt
White(1): ketikkan go <enter> dan
analisa akan berjalan dan tampak
langkah yang diambil oleh komputer
yaitu d4.
Setelah itu pada prompt Black (1)
ketikkn quit dan kembali ke prompt $

PINDAH DIREKTORI
Anda berada di ~/chess-5.02/src
dan software yang diperlukan untuk
pembentukan file ada di sini. Untuk
melihat direktori di atasnya, pada
prompt $ ketikkan ls .. (antara ls dan
dua titik ini ada spasi) lalu <enter> .
Tampak bahwa setingkat dengan src
terdapat pula direktori book dan doc

KEMBALI KE DIREKTORI SRC
Untuk kembali ke direktori src, pada
prompt $ ketikkan cd .. (jangan lupa
spasi sebelum dua titik) lkalu <enter>
dan ketikkan lagi cd src <enter> dab
anda kembali ke direktori src yang
kini sudah disalinkan file book.pgn
PGN adalah portable game notation,
suatu konvensi penulisan permainan.

PENGISIAN BOOK.DAT
Pengisian book.dat dengan informasi
dari book.pgn ini dapat berjalan be-
berapa jam lamanya. Bila anda tidak
sabar, tekan Ctrl-C untuk menghen-
tikannya dan mungkin ingin mem-
bentuk book.dat yang lebih kecil.
Lihat petunjuk pada file install yang
dibuka dengan Winword.

MEMBENTUK BOOK.DAT
Untuk membentuk book.dat, jalankan
dulu gnuchess.exe dengan cara me-
ngetikkan ./gnuchess <enter> dan
akan tampil prompt langkah pertama
yaitu White (1): Pada prompt ini
ketikkan book add book.pgn yang
akan menambahkan data dari book.pgn
ke book.dat kosong yang sudah ada.

Gnuchess.exe adalah suatu chess engine yang tangguh!

CCYYGGWWIINN
MMEEMMBBEENNTTUUK GK GNNUUCCHHEESSS.ES.EXXEE
DDAN OAN OTTAKAKNNYYA (BA (BOOOOK.DK.DAAT)T)
Perintah make akan membentuk file gnuchess.exe yang dapat
dijalankan pada lingkungan Cygwin. Adapun ‘otak’ dari program
catur gnuchess.exe ini terdapat pada file book.dat. Book.dat dapat
terus-menerus diperkaya dengan menambahkan data dari book.pgn
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PINDAH KE DIREKTORI BOOK
Pindah ke direktori book dengan
cara mengetikkan (pada prompt $)
cd .. (antara cd dan dua titik ada
spasi) lalu <enter> yang artinya
naik ke tingkat direktori di atasnya.
Setelah itu masuk ke direktori book
dengan mengetikkan cd book
<enter>.

ADA APA DI DIREKTORI BOOK?
Pada direktori book ini terdapat file
book.pgn yang merupakan file teks
yang berisi berbagai catatan langkah-
langkah permainan catur. File ini
hendak kita ubah menjadi book.dat
dan akan menjadi ‘otak’ bagi program
gnuchess.exe kita. Ketik ls <enter>
untuk melihatnya.

COPY BOOK.PGN KE SRC
Copy file book.pgn dari direktori ini
ke direktori ~/chess-5.02/src
dengan nama yang sama. Caranya
pada pronpt $ ketikkan
cp book.pgn ~/chess-5.02/src/
book.pgn

AYO KITA MAIN!
Setelah proses pembentukan book.dat
selesai, anda dapat bermain melawan
komputer dengan menjalankan
gnuchess dari prompt $ dengan
mengetikkan ./gnuchess <enter>.
Misalnya pada prompt White (1):
anda ketikkan d4 yaitu menjalankan
bidak kempat dari kiri dua langkah.

LAWAN YANG TANGGUH
Gnuchess.exe dengan koleksi lang-
kah-langkah pada book.dat akan
menjadi lawan anda yang tangguh.
Setelah ‘berpikir’ sebentar, gnuchess
akan memberi jawaban Nf6 yaitu
menjalankan kNight (kuda) ke
posisi f6. Kini giliran anda lagi
setelah tampil prompt White (2):

MINTA GNUCHESS YANG MIKIR
Kalau anda ‘buntu’ harus mengambil
langkah apa, pada prompt White (2):
ini ketikkan go <enter> dan gnuchess
akan ‘berpikir’ sebentar untuk anda
dan memberikan jalan. Dalam hal ini
jalan yang dipilihkan adalah Bg5
yaitu memindahkan Bishop (menteri)
ke posisi g5.

1 2 3
AKHIRNYA! GNUCHESS.EXE
Akhirnya anda sampai pada
langkah terakhir, yaitu membentuk
file program gnuchess.exe. Untuk
itu, dari prompt $ ketikkan make
<enter> dan proses pembentukan
file gnuchess.exe akan terlihat.

MAKEFILE TELAH TERBENTUK
Untuk memastikan bahwa makefile
telah terbentuk, pada prompt $
ketikkan ls dan tampak bahwa di
antara file-file yang terbentuk adalah
file makefile yang dibentuk dari
makefile.in lewat perintah ./configure

MENGUJI SOFTWARE
Untuk menguji software ini, dari
prompt $ ketikkan ./gnuchess
<enter> dan permainan pun
dimulai. Permainan catur ini
menggunakan kode-kode untuk
langkah-langkahnya, jadi belum
user-friendly.
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ada NeoTek Vol II No. 2
(November 2001) telah di-
bahas cara menciptakan

Unix shell account di sdf.lonestar.org

Kini setelah mempunyai unix shell
account, kita akan mencoba meman-
faatkannya untuk memainkan pro-
gram catur gnuchess.exe yang telah
anda buat pada cygwin di komputer
Windows anda.

Untuk itu fasilitas Telnet Windows
tidaklah memadai lagi karena hanya
memberikan fasilitas login saja.

Untuk memainkan gnuchess.exe yang
telah anda buat itu pada unix shell,
anda harus meng-upload-nya, padahal

P

DOWNLOAD ZOC 4.0.3
Arahkan browser anda ke alamat ini:
http://www.tucows.com/
preview/195271.html dan
download ZOC Terminal Emulator
4.0.3. Setelah diinstalasi, ZOC
Terminal Emulator dapat dijalankan
dengan memilih Start > Programs >
ZOC Terminal > ZOC

1

7 8

2 3

9

AKSES KE SDF.LONESTAR.ORG
Begitu ZOC dijalankan, anda akan
mendapatkan jendela Manual
Connection. Isikan Connect to
dengan sdf.lonestar.org. Adapun
device tetap Telnet dan Emulator
biarkan saja ANSI BBS. Klik OK untuk
connect.

CONNECT!
Terlihat proses koneksi pada jendela
AutoConnect dan tak lama kemudian
anda akan diminta login. Bila anda
belum mempunyai account di sini,
ketikkan ‘new’ dan ikuti cara pendaf-
taran account di NeoTek November
2001 hlm. 24. Bila sudah mempunyai
account ketikkan account name anda.

PROSES UPLOAD
Proses Upload akan berlangsung be-
berapa lama sesuai dengan kecepat-
an akses internet anda serta ukuran
file yang di-Upload. Ada pilihan untuk
Disconnect after transfer dan
Delete file after transfer. Biarkan
saja keduanya kosong.

GNUCHESS.EXE DI SERVER 
Untuk memastikan bahwa
gnuchess.exe sudah benar-benar
terdapat pada server ini, pada
prompt $ ketikkan ls (huruf kecil)
llau tekan <enter> dan file
gnichess.exe akan ditampilkan lalu
kembali ke prompt $

UPLOAD SELESAI
Setelah Upload selesai, terlihat pesan
Upload Zmodem
gnuchess.exe (keterangan waktu upload)
rz 3.54 10-19-99 finished.
yang menandai bahwa gnuchess.exe
telah berhasil di-pload. Anda kembali
akan mendapatkan prompt $

Manfaatkan fasilitas Zmodem pada ZOC Terminal Emulator

UU NN II X SX S HH EE LL GLL G RR AATTII SS
UUNNTTUUK MK MEENNJJALALANANKKANAN
GGNNUUCCHHEESSS.ES.EXXE ANE ANDDAA
Account unix shell gratis banyak memberi pembatasan, seperti
kuota disk yang disediakan serta perintah-perintah Unix/Linux yang
boleh digunakan. Lebih lanjut lagi terkadang kita tidak diperkenan-
kan mengakses servernya melalui FTP. Untuk itu gunakan fasilitas
Zmodem untuk upload dan download file ke unix shell server.
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free account pada sdf.lonestar.org mem-
batasi baik kuota disk yang disediakan
maupun perintah-perintah Unix/Linux
yang boleh dijalankan pada shell itu.

Kita tidak mungkin mengkompilasi
program gnuchess.exe langsung pada
unix shell account ini karenma selain
ukuran source codfe-nya melebihi
kuota (hampir 30 megabyte), juga
karena kita tidak diizinkan menjalan-
kan perintah mmaakkee di situ.

Lebih lanjut lagi, kita juga tidak diper-
kenankan melakukan akses FTP ke
uniz shell account ini.

Namun tidak perlu khawatir, sebab
kita telah mempunyai Cygwin dan

kini dapat pula men-download ZOC
Terminal Emulator yang juga mem-
punyai fasilitas upload dan download.

Cygwin pada Windows dapat kita guna-
kan untuk mengkompilasi source code
Unix, sedangkan ZOC Terminal Emu-
lator akan kita gunakan untuk meng-
upload file gnuchess.exe yang dihasilkan
dari proses di bawah Cygwin ini.

Setelah di-Upload, file gnuchess.exe
ini dapat dijalankan seperti halnya
dibawah Cygwin, tetapi dalam hal ini
kita tidak perlu menggunakan
cygwin1.dll karena kini gnuchess.exe
kita berjalan langsung pada unix box-
nya sdf.lonestar.org.

Untuk eksplorasi lebih lanjut, silakan
periksa kemungkinan menggunakan
Xboard sebagai interface grafisnys
(setara dengan Winboard yang untuk
Windows). Untuk dapat mengkompi-
lasi Xboard pada Cygwin (ataupun
lingkungan Unix/Linux lainnya)
diperlukan X Windows system.

Dapatkan Xboard di
hhttttpp::////wwwwww..ttiimm--mmaannnn..oorrgg//xxbbooaarrdd..hhttmmll
sedangkan X Windows System di
hhttttpp::////wwwwww..xxffrreeee8866..oorrgg//
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PROMPT $ YANG KHAS ITU
Setelah memasukkan nama account
anda pada login dan password-
nya, anda akan masuk ke server
sdf.lonestar.org dan mendapatkan
prompt $ yang khas untuk
Unix/Linux itu. Nah sekarang apa
yang dapat kita lakukan pada ruang
yang masih kosong ini?

UPLOAD FILE
ZOC Terminal Emulator mempunyai
fasilitas Transfer yang dibagi lagi
atas Upload, Download, Send
Textfile, dan Send Binary File. Kita
pilih Transfer > Upload

UPLOAD GNUCHESS.EXE
Setelah memilih Upload, jendela
Select Zmodem-Upload File(s).
akan ditampilkan. Cari file yang
hendak di-Upload, dalam hal ini
adalah gnuchess.exe. Begitu file ini
di-Open maka proses Upload segera
berlangsung.

MAINKAN GNUCHESS.EXE
Untuk memainkan gnuchess.exe, anda
cukup mengetikkan
gnuchess <enter>
dan permainan akan berlangsung
dengan meminta anda jalan duluan
dengan prompt
White (1):

MEMBUKA DENGAN d4
Misalkan anda memulai dengan d4
yaitu menggerakan bidak (Pawn)
ke posisi d4, maka setelah
‘berpikir’ sebentar, gnuchess akan
memberikan langkahnya, yang
dalam hal ini adalah d5, yaitu
menggerakan bidak ke posisi d5.

DAPAT UNTUK BELAJAR
Bila tak tahu apa yang harus dilaku-
kan, ketikkan go dan gnuchess.exe
akan menjalankan langkah anda,
dalam hal ini Nf3, yaitu menggerak-
kan kNight (kuda) ke posisi f3.
Pelajari sendiri bagaimana menggu-
nakan Xboard untuk interface grafisnya.
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erhasil sudah menciptakan
gnuchess.exe dari source
code-nya. Tapi penampilan-

nya kok tidak menarik?

Jangan khawatir, gunakan Winboard
sebagai interface grafisnya. Setelah
instalasi otomatis, Winboard juga da-
pat diinstalasi secara manual agar
menggunakan chess engine yang
sudah anda ciptakan dari source code-
nya, baik itu gnuchess maupun Crafty.

Ada lagi Zippy yang dapat menjadi-
kan gnuchess anda menjadi chess bot
untuk dipertandingkan pada chess
game server (untuk Xboard/Unix).

Semakin terasa manfaat Unix, bukan?

B

MEMBACA FILE PGN DAN FEN?
Sewaktu instalasi akan tampil per-
tanyaan apakah anda menginginkan
Winboard membaca file-file PGN
dan FEN. Pilih Yes dan teruskan
instalasi sampai selesai yang akan
meletakkan Winboard pada Start
Menu dari Windows.
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JALANKAN WINBOARD
Pilih Start > Programs > Winboard
dan pilih Winboard Startup Dialog
yang akan memunculkan  pilihan
dalam anda menjallankan Winboard,
apakah bermain dengan chess engine
(misalnya gnuchess,exe), link ke
chess server, atau sekedar melihat
dan mengedit game file.

PINDAH DIREKTORI
Pilih play against a chess engine
or match two engines. Lalu pilih
dua chess engine. Di sini pilihannya
adalah GNUChess (gnuchess versi 4)
dan “GNUChes5 xboard” (gnuchess
versi 5) yang sudah terpasang
bersamaan dengan Winboard.

INSTALASI MANUAL
Dikatakan bahwa untuk menginstal-
asi secara manual, anda perlu mem-
buat direktori tersendiri dan menyalin
file-file di atas. gnuchess.* adalah file-
file gnuchess 4 sedangkan
gnuches5.exe adalah file gnuchess
versi 5. Pilih file-file untuk ditaruh di
durektori khusus misalnya C:\Chess

UBAH CONFIGURATION SETTING
Agar program dapat berjalan maka
pada direktori itu perlu juga ditam-
bahkan file cygwin1.dll (dari Cygwin)
dan book.pgn (dari Chess-5.02).
Kemudian dengan Notepad buka file
winboard.ini dan ubah teks pada
firstChessProgramNames dan second
ChessProgramNames seperti di atas.

DENGAN GNUCHESS.EXE KITA
Dari Winboard pilih winboard.exe,
winboard.hlp, dan winboard.ini.
Juga pilih gnuchess.* (exe, dat, dan
lan) serta ubah semuanya jadi
gnuchess4.* Adapun dari hasil
kompilasi kita sendiri pada Cygwin
pilih gnuchess.exe yang di-rename
jadi gnuchess5+.exe

Winboard dan Xboard membuat chess engine tampak lebih menarik

WWII NN BBOOARAR DD
IINNTTEERRFFAACCE GE GRRAFAFIIS US UNNTTUUKK
GGNNUUCCHHEESSS.ES.EXXEE
Gnuchess.exe pada dasarnya merupakan suatu chess engine yang
dapat dipasangkan pada suatu interface grafis, yaitu Xboard (untuk
sistem Unix) dan Winboard (untuk Windows). Selain itu Winboard
juga dapat digunakan untuk mempertandingkan dua chess engine!
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PILIH GNUCHESS
Misalkan kita pilih GNUChess pada
kedua pilihan tadi, maka pada kedua
sisi hitam dan putih masing-masing
dijalankan oleh chess engine yang
sama yaitu GNUChess (dalam hal
ini GNUChess 4). Klik Mode dan
anda bisa pilih mau melawan mesin
atau mengadu kedua mesin.

MELAWAN GNUCHESS
Karena dipilih GNUChess dan pada
Mode dipilih Machine Black,
maka anda harus jalan terlebih
dahulu (putih). Misalkan langkah
pertama anda adalah d4 yaitu
bidak dari d2 pindah ke d4.
GNUChess akan menjawab dengan
Nf6

MEMPELAJARI LEBIH JAUH
Untuk mempelajari lebih jauh
instalasi Winboard dengan gnuchess
ini buka file READ_ME yang
terdapat pada direktori C:\Program
Files\Winboard dengan mengklik
dua kali icon-nya. File ini akan
dibuka oleh Notepad.

PILIHAN CHESS ENGINE
Sewaktu menjalankan Winboard
Startup, pilihan chess engine-nya
sudah sesuai dengan yang kita
tetapkan pada winboard.ini, yaitu
GNUChess4 dan GNUChess5+ (yaitu
gnuchess.exe yang kita buat pada
Cygwin sebelumnya dan di-rename
menjadi GNUChess5+.exe

GNUCHESS4 VS. GNUCHESS5+
Setelah memilih GNUChess4 dan
GNUChess5+ sewaktu memilih dua
engine, pilih menu Mode
kemudian pilih lagi Two Machines
dan akan terjadi pertandingan
antara GNUChess4 (putih)
melawan GNUChess5+ (hitam).

CHESS ENGINE LAIN
Pada Winboard kita dapat mema-
sangkan chess engine lain lagi. Yang
populer adalah Crafty. Download
source code Crafty di sini:
ftp://ftp.cis.uab.edu/pub/hyatt/
games/
Coba sendiri membentuk file exe dari
Crafty dengan Cygwin.

1 2 3
DOWNLOAD WINBOARD
Download versi terakhir Winboard,
yaitu versi 4.2.3 dengan meng-klik
link-nya. Pilih Save this program to
disk. Misalkan simpan di direktori
C:\Download.

XBOARD DAN WINBOARD
Arahkan browser anda ke
http://www.tim-mann.org/xboard.html
Terbaca di sini bahwa bila Xboard
untuk sistem Unix, maka Winboard
untuk Windows.

INSTALASI WINBOARD
Double click file winboard-4_2_3.exe
dan installation wizard akan
ditampilkan. Ikuti saja langkah-
langkahnya sampai instalasi selesai.



NeoEdu

46 NeoTek Januari 2002

engetikkan rumus-rumus
molekul pada mesin tik me-
mang sulit dan word processor

tidak membuatnya lebih mudah.
Bila untuk rumus-rumus matematika
dapat menggunakan Equation Editor
yang tersedia pada Word, maka kini
untuk rumus-rumus kimia tersedia
ChemSketch.

ChemSketch bukan hanya untuk me-
nuliskan rumus-rumus kimia yang
kemudai diekspor sebagai file grafik,
namun juga cara penulisannya seperti
menghubungkan mata-mata rantai
yang senyawa yang dihasilkannya
dapat diperiksa kebenarannya dengan
menghitung sifat-sifat kimia fisiknya.

RRUUMMUUS MS MOOLELEKKUULL
DDEENNGGANAN
CCHHEEMMSSKKEETTCCHH
Penulisan rumus-rumus molekul merupakan kesulitan tersendiri
baik untuk para guru yang membuat soal ujian maupun para
siswa dan mahasiswa yang membuat paper atau skripsi. Kini
dengan ChemSketch anda dapat membuat rumus-rumus kimia
yang kompleks dengan mudah menggunakan template yang
disediakan. Hasilnya dapat diekspor menjadi file-file grafis.

M

Menuliskan rumus molekul dengan logika kimia bukan logika matematika

Ubah Kedua O dengan C
Dengan mengklik O pada -OH maka
-OH akan berubah menjadi --CH3.
Kemudian tarik ke kanan untuk mem-
buat percabangan -CH3 ke sebelah
kanan cincin sebelah kiri. Hal yang
serupa dengan cincin yang kedua
pada -OH yang sebelah kiri bawah

Ganti Salah Salah satu C dengan O
Kini pilih O dan klik di C dari  -CH3
yang baru dibentuk pada cincin
sebelah kanan. Tampak -CH3
akan berubah menjadi -OH. -CH3
dan -OH kini dapat ‘direaksikan’
membentuk ikatan -O-

-CH2 yang Seharusnya Kosong
Ikatan -O- kini telah dibentuk antara
kedua cincin α-D-Pyranose ini, tapi
cara membuatnya ‘diakali’ dengan
menyisipkan dua karbon. Kedua
karbon ini kini ada dalam bentuk
-CH2 dan ini harus kita hapus.

Menjalankan ChemSketch
Jalankan ChemSketch dengan
memilih Start > Programs >
ADCLabs Freeware 5.0 dan pilih
ChemSketch akan tampil format
file yang di-support. Klik
keduanya danpilih OK.

Logic Circuits
Kita akan menggambarkan rumus
molekul maltosa yang terdiri dari
dua cincin glukosa dengan ikatan α.
Pilihtemplate pada icon kedua dari
paling kanan di sisi atas layar

Banyak Pilihan
dari pelbagai template yang ada
pilih templat Sugars; alfa-D-Pyr
(opsi di kiri layar) dan pada opsi
di bagian atas pilih 1(4) Haworth
Formulae. Klik pada template α-
D-Pyranose dan anda akan masuk
ke halaman Editor dengan template
yang anda pilih itu.
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Nilai Sudut yang Kosong
Bila mouse diletakkan di atas
sudut itu akan tampak -CH2- dan
ini harus dikosongkan. Caranya
double click pada sudut itu dan
akan muncul kotak dialog
Properties. Pilih C dan pilih
Value sebagai Empty. Klik Apply.

Hitung Sifat-sifat Kimianya
Lakukan hal yang sama pada sudut
yang berisi -CH2- di cincin yang
kedua. Dan penulisan rumus mo-
lekul maltosa selesai! Aktifkan menu
Select/Move di kiri atas, select
keseluruhan molekul, lalu hitung
properties-nya dengan Tools >
Calculate > All Properties

Properties Dihitung
Akan tampil jendela kecil yang
menghitung properties molekul ini.
Bila dapat ditampilkan artinya
struktur yang dibuat sudah benar.
Pilih properties yang ingin ditam-
pilkan dengan klik, Shift, dan panah,
lalu klik tombol Copy to Editor

Letakkan dengan Klik
Letakkan template cincin pada bi-
dang gambar dengan cara klik se-
kali dan geser ke kanan untuk me-
letakkan template kedua di sebe-
lah kanannya. Maltosa terdiri dari
dua cincin glukosa dalam bentuk
α-D-Pyranose. Kedua cincin ini
akan kita hubungkan.

Meletakkan yang Kedua
Klik sekali lagi untuk meletakkan
cincin yang kedua di sebelah ka-
nan yang pertama. Untuk mem-
buang template ini dari clipboard,
klik kanan sekali dan anda dapat
melanjutkan ke proses berikutnya

Mengubah Struktur
Untuk mengubah struktur kimia
yang dituliskan, pilih Structure pada
bagian kiri atas dan akan tampak
atom-atom yang dapat kita pilih
untuk menggantikan atom pada
struktur yang ada. Kita pilih C
(karbon) untuk menggantikan -OH
menjadi -CH3
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Masuk ke Situs ACD
Download ChemSketch dari situs
Advanced Chemical Development
http://www.acdlabs.com/download/
chemsk.html Selain ChemSketch
anda dapat men-download soft-
ware lain yang berhungan termasuk
bahasa pemrograman ChemBasic.

Daftar Dulu 
Anda diminta untuk mendaftar dulu
dengan memasukkan informasi
pribadi anda. Setalah itu kembali
ke halaman login dan download
chemsk50.exe yang besarnya 8,5
Mbyte. ChemSketch dan lain-lainnya
dapat juga diperoleh di CD NeoTek
bulan ini

Instalasi ChemSketch
Istalasi ChemSketch cukup de-
ngan double click pada icon
chemsk50 dan prsoes instalasi
akan berjalan secara otomatis.
Ikuti saja langkah-langkahnya
sampai selesai.
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ini tidak ada lagi alasan sulit
belajar struktur molekul, khu-
susnya secara stereometri, se-

bab modelling molekul kimia apa saja
dapat dilakukan pada PC anda dengan
ChemSketch yang menyertakan juga
3D Viewer.
Sekali rumus molekul telah berhasil
digambar dan dapat dihitung proper-
ties-nya maka dapat diekspor sebagai
bitmap graphics untuk disisipkan pada
word processor ataupun dapat dilihat
gambaran tiga dimensinya dengan 3D
Viewer.

Semuanya begitu mudah dan software-
nya tersedia gratis di Internet. Ini alasan
kuat guru kimia perlu belajar Internet!

ANANIIMAMASSI 3D FI 3D FIILELE
CCHHEEMMSSKKEETTCCH H DDEENNGGANAN
ADADC/3D VIC/3D VIEWEEWERR
Rumus molekul yang dibuat dengan ChemSketch bukanlah suatu
gambar ‘mati,’ melainkan berisi informasi-infoemasi penting tentang
struktur molekul yang dapat ditampilkan pada browser khusus,
yaitu ADC/3D Viewer yang menggambarkan struktur molekul ini
dalam tiga dimensi. Dapat dioptimasi jarak, sudut, dan torsinya.
Serta dapat dianimasi dalam berbagai bentuk!

K

Membuat animasi 3D dengan ChemSketch

Sudut Tiga Atom
Demikian juga untuk
mengetahui sudut yang dibentuk
oleh tiga atom, pilih Tools >
Measure Bond Angle lalu pilih
tiga atom yang membentuk
sudut. Sudutnya terbaca di
bagian bawah layar.

Untuk Presentasi
Radius inti atom yang ditampilkan
dapat diperbesar ataupun diper-
kecil dengan kelipatan 5%. Bila
diperbesar terus akan berbentuk
space filling penuh, Ini memu-
dahkan untuk melihat hubungan
antara Balls & Sticks dengan
Space Filling. 

Main-mainkan Penampilannya
Main-mainkan penampilan mole-
kul ini untuk mendapatkan gam-
baran yang lebih jelas mengenai
bentuk molekulnya serta bagai-
mana sifat kimia dapat ditentukan
dari bentuk stereometrinya. Dengan
model plastik hal ini sama sekali
tidak mungkin!

Jalankan 3D Viewer
Pilih ACD/Labs lalu 3D Viewer
untuk mengaktifkan 3D Viewer.
Layar 3D Viewer akan terbuka
denganrumus molekul maltosa
dalam bentuk wireframe. Bentuk
ini dapat diubah ke Sticks, Balsl &
Sticks, Dots Only, Disks, dan
Spacefill.

Pilih Balls & Sticks
Misalkan kita pilih model Balls &
Sticks. Kelihatan lebih baik tapi
masih kurang sempurna bukan? Ini
karena posisi relatif atom-atom
belum teroptimasi dalam ruang tiga
dimensi. Untuk itu pilih Tools > 3D
Optimization.

Stereomerinya yang Baik
Molekul maltosa itu akan teropti-
misasi posisi atom-atomnya satu
sama lain. perhatikan bahwa cin-
cin segi enam bukanlah pada
bidang datar, melainkan berben-
tuk konfigurasi kursi akibat inter-
aksi antaratom dalam molekul.
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Rotasi
Untuk lebih jelas lagi gambaran
tiga dimensinya rotasikan mole-
kul ini baik dengan mengguna-
kan mouse maupun dengan fa-
silitas AutoRotate. Ada lagi
Autorotate and Change Style.

Kembali ke Bitmap File
Kembali ke file bitmap yang di-
buat dengan fasilitas Export tadi.
Buka Microsoft Word dan pilih
Insert > Picture > From File
dan pilih gambar yang dibentuk
tadi misalnya maltosa.bmp dan
klik Open.

Gambar Di-Insert pada Word
Gambar maltosa.bmp sudah masuk
kedalam skripsi anda yang diketik
dengan Word. Anda kini tidak per-
lu bersusah payah menuliskan ru-
mus-rumus molekul tiga dimensi
dengan tangan lagi.

‘Ukuran’ Molekulnya?
Untuk melihat’ukuran’ molekul
maltosa ini atau tepatnya ‘space
filling’-nya pilih View > With Dots
dan diameter-diameter setiap
atom secara relatif akan digam-
barkan. Cara ini nyaris mustahil
digambarkan secara manual.

Jarak Antaratom?
Untuk mengetahui jarak antaratom
(dari inti atom ke inti atom lainnya),
pilih Tools > Measure Distance.
Perhatikan masih banayak fasilitas
lain seperti mengukur sudut ikatan
serta sudut torsi atom-atom dalam
molekul.

Jarak Dua C pada Cincin
Klik dua atom yang hendak diukur
jaraknya. Dalam hal ini adalah dua
atom C pada cincin α-D-Pyranose.
Kedua atom yang dipilih akan di-
warnai hijau dan ukurannya dapat
dibaca di sebelah bawah layar.
Dalam hal ini 1,4283 Ångstrom.
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Kembali ke Editor
Anda kembali ke Editor dan pro-
perties yang dipilih sudah ter-
paste pada halaman gambar
anda. Posisinya dapat anda ubah-
ubah. Misalkan letakkan di ba-
wah rumus molekul maltosa
yang baru dibuat tadi.

Siap untuk Selanjutnya
Setelah proses selanjutnya ada
dua. Pertama membuat gambar
statis berupa bitmap image yang
dapat disisipkan pada dokumen-
dokumen lain, misalnya pada
Microsoft Word. Kedua adalah
melihat molekul ini secara 3D

Ekspor ke File
Pilih File > Export dan jandela
dialog Export akan tampil. Pilih
ingin diekspor ke foledr mana
dengan nama apa dan sebagai file
apa. Selain tipe PDF yang lain
dapat berjalan.
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